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IInnttrroodduuccttiioonn

Important

To the maximum extent permitted by applicable laws, in no event will the manufacturer be liable for any
damages whatsoever arising out of failures of this product, losses of documents or data, or the use or
non-use of this product and operation manuals provided with it.

Make sure that you always copy or have backups of important documents or data. Documents or data
might be erased due to your operational errors or malfunctions of the software. Also, you are
responsible for taking protective measures against computer viruses, worms, and other harmful software.

In no event will the manufacturer be responsible for any documents created by you using this product or
any results from the data executed by you.

Cautions regarding this guide

• Some illustrations or explanations in this guide could differ from your product due to improvement or
change in the product.

• The contents of this document are subject to change without notice.

• No part of this document may be duplicated, replicated, reproduced in any form, modified, or
quoted without prior consent of the supplier.

• Throughout this publication, references to directory paths indicate the default paths only. If you
install RICOH ProcessDirector Plug-in for Adobe Acrobat in a different location, including a different
drive, you must adjust the paths accordingly.
For example, if you install RICOH ProcessDirector Plug-in for Adobe Acrobat on the D: drive of a
computer running a Windows operating system, replace C: with D: in the directory paths.

Publications for this product

The following publications are available for RICOH ProcessDirector Plug-in for Adobe Acrobat.

Instruction manuals

These instruction manuals are included:

• RICOH ProcessDirector: Integrating with Other Applications

This guide provides technical information about the ways that you can configure RICOH
ProcessDirector to exchange data with other applications.

• RICOH ProcessDirector for Linux or Windows: Planning and Installing

This guide explains planning and installation procedures for RICOH ProcessDirector on your
operating system. The publications CD includes the version of this manual for your operating system:
Linux or Windows.

• RICOH ProcessDirector: Installing Document Processing Features



This guide explains how to install RICOH ProcessDirector features that control and track both jobs
and the individual documents in jobs.

• RICOH ProcessDirector: Using RICOH ProcessDirector Plug-in for Adobe Acrobat (this publication)
This guide explains how to use RICOH ProcessDirector Plug-in for Adobe Acrobat. You can use the
Adobe Acrobat plug-in to define text, barcodes, images, and other enhancements in a PDF file.
After you save your enhancements in a control file, RICOH ProcessDirector workflows can use the
control file to make similar enhancements to PDF files.

• Font Summary

This guide explains font concepts and the different types of fonts in the InfoPrint Font Collection. The
Font Summary is available only in English.

• White Paper–Using the Enhance AFP Function

This guide explains how to configure and use Enhance AFP control files. The guide is available only
in English.

• The RICOH ProcessDirector readme file (readme.html)
This file tells you how to access the other publications. The readme file is available only in English.

• The RICOH ProcessDirector release notes
These release notes provide information about the RICOH ProcessDirector release, including new
functions and updates; known limitations, problems, and workarounds; and code change requests.
The release notes are available only in English.

You can download English publications in PDF format from the RICOH Software Information Center
(https://help.ricohsoftware.com/swinfocenter/).

RICOH ProcessDirector Information Center

The RICOH ProcessDirector Information Center contains topics that help administrators, supervisors, and
operators learn about and use RICOH ProcessDirector document features. The Information Center is
available from the RICOH ProcessDirector user interface and provides quick navigation and search
features.

RICOH ProcessDirector Help

Field help is available on many screens for RICOH ProcessDirector document processing features to
provide information for specific tasks and settings.

How to read the documentation

Before using RICOH ProcessDirector Plug-in for Adobe Acrobat

This manual contains instructions and cautions for correct use of RICOH ProcessDirector Plug-in for
Adobe Acrobat. Before using RICOH ProcessDirector Plug-in for Adobe Acrobat, read this manual
thoroughly and completely. Keep this manual handy for future reference.

How to use the manuals

Use the instruction manuals according to your needs.

To learn how to install RICOH ProcessDirector Plug-in for Adobe Acrobat:
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See RICOH ProcessDirector: Installing Document Processing Features.

To learn how to use the functions and operations of RICOH ProcessDirector Plug-in for Adobe
Acrobat:

See RICOH ProcessDirector: Using RICOH ProcessDirector Plug-in for Adobe Acrobat. This information is
also available in the plug-in help system and the RICOH ProcessDirector Information Center.

Displaying the publications

RICOH ProcessDirector: Installing Document Processing Features is available when you run the installation
program, so you can access the publication while you install the application.

RICOH ProcessDirector: Installing Document Processing Features and RICOH ProcessDirector: Using RICOH
ProcessDirector Plug-in for Adobe Acrobat are also available from the RICOH ProcessDirector user
interface.

On the top menu bar of the RICOH ProcessDirector user interface, click the button and select one
of the publications to download.

• A PDF viewer, such as Adobe Acrobat Reader, is required to view the publications.

• You must log in RICOH ProcessDirector user interface to view the publications.

Displaying the help system

The RICOH ProcessDirector Plug-in for Adobe Acrobat help system is available from the application.
Click Help on a dialog.

Related information

For information about our products, see:

• RICOH Software Information Center (https://help.ricohsoftware.com/swinfocenter/)

Symbols

The following symbols are used in this manual to help you to identify content quickly.

• This symbol indicates points to pay attention to when using the product. Be sure to read these
explanations.

• This symbol indicates helpful supplementary information that is not essential to completing a task.

Bold
Bold type indicates the names of dialogs, menus, menu items, settings, field labels, buttons, and
keys.
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IIttaalliicc
Italic type indicates the titles of manuals and variables that you must replace with your own
information.

MMoonnoossppaaccee

Monospace type indicates computer input and output.

Abbreviations

Abbreviations used in this publication.

HTTP
Hyper Text Transfer Protocol

IP
Internet Protocol

OMR
Optical Mark Recognition

PDF
Portable Document Format

Trademarks

RICOH ProcessDirector™ is a trademark of Ricoh Company, Ltd. in the United States, other countries,
or both.

Adobe, Reader, and PostScript are either registered trademarks or trademarks of Adobe Systems, Inc in
the United States and/or other countries.

Microsoft, Windows, Windows Server, and Internet Explorer are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX is a registered trademark of The Open Group.

Sentinel® is a registered trademark of Thales DIS CPL USA, Inc.

The proper names of the Windows operating systems are as follows:

• The product names of Windows 7 are as follows:

Microsoft Windows 7 Professional

Microsoft Windows 7 Ultimate

Microsoft Windows 7 Enterprise

• The product names of Windows 10 are as follows:

Microsoft Windows 10 Pro
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Microsoft Windows 10 Enterprise

• The product name of Windows 11 is:

Microsoft Windows 11 Pro

• The product names of Windows Server 2016 are as follows:

Microsoft Windows Server 2016 Standard

• The product name of Windows Server 2019 is:

Microsoft Windows Server 2019 Standard

• The product name of Windows Server 2022 is:

Microsoft Windows Server 2022 Standard

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.
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11.. Overview

•Page groups
•Document properties
•Conditional processing
•Markup
•Control files
•Sample PDF files

RICOH ProcessDirector Plug-in for Adobe Acrobat is an Adobe Acrobat Professional plug-in that you
use to define and display enhancements in a PDF file that represents the PDF files that are processed by
the steps in your workflows.

Enhancements include barcodes, OMR marks, images, hidden areas, and text. The enhancements you
define in the PDF file are not saved in the PDF file; instead, they are saved in control files that you make
available to a server used by RICOH ProcessDirector. RICOH ProcessDirector uses the control files to
apply the same enhancements to production PDF files when it processes them for printing.

To extend markup capabilities, RICOH ProcessDirector Plug-in for Adobe Acrobat provides page
groups, document properties, and conditional processing.

PPaaggee ggrroouuppss
A page group is a set of pages that make up a single document, such as a mailpiece or customer
statement, within a PDF file. In RICOH ProcessDirector Plug-in for Adobe Acrobat, a document is a page
group. A single PDF file can contain many documents. If an entire PDF file is treated as a single page
group, the PDF file represents one document.

You should define a page group before you add markup. After you define a page group, you can
apply markup to specific pages in each document. For example, you can add a barcode to the first
page of each document, an image to all front-facing pages of each document, or text to the first back-
facing page of each document.

You can define a page group in these ways:

• As the entire PDF file.

• As a fixed number of pages.

• Based on text you select that is in the same location on the first page of each page group.

RICOH ProcessDirector Plug-in for Adobe Acrobat uses the repeated text to determine the first page
of each page group. For example, you have 100,000 customer statements in one PDF file. Each
statement has three or more pages. To define a page group, you select Page 1 of, which is in the
same location on the first page of each statement.

If you are using a sample PDF file to define page groups, make sure that the content and location of
the text you select are consistent among the production PDF files.

• Based on a specific key word or phrase that appears on the first page of a document within a
region of text. The surrounding text might change, but the key word or phrase remains the same.

• Based on text you specify that is on the first page of each page group. When you type the text, you
can include wildcard characters. RICOH ProcessDirector Plug-in for Adobe Acrobat interprets the
wildcard characters as any character.
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• Based on Java regular expressions that you define to specify text on the first page of each page
group.

For example, you define a Java regular expression so that RICOH ProcessDirector Plug-in for
Adobe Acrobat starts a new page group each time it finds the English text Page 1 of or the Spanish
text Página 1 de.

• When text in a selected area changes.

For example, you draw a box around the account name on a statement in a PDF file. Whenever the
text in the box changes, that page becomes the first page of a new page group. The location of the
box on every page must encompass only the text to evaluate or white space (no text).

Use the Page Group Navigator to see a list of the pages in each page group. After you verify that the
page groups are correct, save your control file, which contains your new page group definition. If you
define document properties, save them in the same control file. You then add the name and location of
the control file to a RICOH ProcessDirector step based on the IdentifyPDFDocuments step template.

DDooccuummeenntt pprrooppeerrttiieess
A document property is data, such as a customer name or postal code, extracted from a specific
location on a page within a document. Using document properties, you can add markup based on
variable information. For example, you can add a different image to documents sent to different states
or provinces.

RICOH ProcessDirector Plug-in for Adobe Acrobat has an advanced address block parsing tool to help
you extract city, state or province, postal code, and other document properties from complex, variable
line addresses. If you need to reprint documents in a job, you can use RICOH ProcessDirector to search
for document property values to find the specific documents you need to reprint.

You can define your own document property or select a RICOH ProcessDirector document property
from a drop-down list. You can use RICOH ProcessDirector document properties with functions
provided by RICOH ProcessDirector document processing features.

When you use RICOH ProcessDirector Plug-in for Adobe Acrobat to define document properties, you
select from a list of your RICOH ProcessDirector document properties. After you install RICOH
ProcessDirector Plug-in for Adobe Acrobat or any time that you change RICOH ProcessDirector
document properties, you need to load the document properties into RICOH ProcessDirector Plug-in for
Adobe Acrobat. For more information, see RICOH ProcessDirector: Installing Document Processing Features.

Click Ricoh→ View Document Property Values to verify that document property values are
extracted correctly.

If you want to use document property values with an external program, you can save the values to a
tab-delimited text file.

CCoonnddiittiioonnaall pprroocceessssiinngg
When you add markup to a PDF file using RICOH ProcessDirector Plug-in for Adobe Acrobat, you can
create conditional processing rules to place the markup on specific pages.You also can use conditional
processing rules to apply media and finishing options and to specify the pages from which RICOH
ProcessDirector Plug-in for Adobe Acrobat and RICOH ProcessDirector extract document property
values.

1 Overview
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Rules can specify conditions based on pages within documents, such as All Front Pages, as well as on
job properties, document properties, statistics, and conditional triggers (text that determines whether a
condition is met).

For example, you want the word Invoice at the top of the first page of a statement to trigger the
placement of a barcode. First, you select the word Invoice and define it as a conditional trigger. Then
you define a rule that specifies the conditional trigger. When you add a barcode to a PDF file, you
specify this rule to control placement of the barcode. The barcode only prints on the pages where the
word Invoice appears in the location specified by the conditional trigger.

Your RICOH ProcessDirector workflows can contain steps that set job property values during RICOH
ProcessDirector processing. If you use RICOH ProcessDirector Plug-in for Adobe Acrobat to define a
rule with a job property, you can dynamically create and alter how the rule is applied by setting the job
property value in RICOH ProcessDirector. For example, you could use the Job.CustomerName job
property to print a barcode only when the value of that property is BANK. RICOH ProcessDirector also
keeps track of job processing statistics, such as the current page in a document. If you want to apply a
barcode to page three in every document in a PDF job, you can make Stat.CurrentPageInDocument
= 3 a condition for the application of a rule.

MMaarrkkuupp
RICOH ProcessDirector Plug-in for Adobe Acrobat supports five types of markup: barcodes, OMR
marks, images, text, and hidden areas.

For each type of markup, you assign a name that identifies the markup contents. Then you assign values
for location, placement, and other properties. You can define document properties and conditional
processing for markup using data that varies by document within the PDF file.

When RICOH ProcessDirector Plug-in for Adobe Acrobat displays a PDF file, your markup appears as
a set of boxes with names. The PDF file is not altered. TheMarkup Navigator lets you locate and edit
markup that is hidden under other markup.

To view and verify the content and placement of your markup on specific pages, you preview the PDF
file. See Previewing markup, p. 20 for more information.

CCoonnttrrooll ffiilleess
A control file saves your page group definition, document properties, conditional triggers, and markup
independently of a PDF source file. Control files are templates that RICOH ProcessDirector uses to apply
the same markup rules to the PDF files it processes.

• Saving your PDF source file by clicking File→ Save or File→ Save As does not save your RICOH
ProcessDirector Plug-in for Adobe Acrobat page groups, document properties, or markup.

To use the RICOH ProcessDirector IdentifyPDFDocuments step in a PDF workflow, you must add the
RICOH ProcessDirector Plug-in for Adobe Acrobat control file that defines page groups or document
properties for that step. Any markup definition must be saved to one or more control files that are used
by the RICOH ProcessDirector BuildPDFFromDocuments step.

You do not need to create separate control files for the page group, document properties, and markup
definitions: all definitions can be saved in one control file if that control file is added to both the
IdentifyPDFDocuments and the BuildPDFFromDocuments steps. However, you might choose to

Markup
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create multiple control files if you can apply one or more control files to different PDF workflows. For
example each workflow might require its own document properties, but some workflows might require
the same area to be hidden to cover OMR marks. For each workflow you would save a separate
control file that defines document properties, but save only one control file to hide OMR marks. In each
workflow, you would specify the workflow-specific control file that defines document properties. But in
the step in each workflow that is based on the BuildPDFFromDocuments step template, you would
specify the same control file that contains the hidden-area definition.

• The IdentifyPDFDocuments step uses one control file to create page groups and extract document
properties. The BuildPDFFromDocuments step optionally uses one or more control files to apply
markup and restructure a PDF file. (BuildPDFFromDocuments does not require a control file.) In
order to preview markup, you must define a page group and the document property definitions
whose values you use in markup content. If you save a page group or property definition to a
control file that you add to the BuildPDFFromDocuments step, RICOH ProcessDirector ignores
those definitions. The BuildPDFFromDocuments step receives page grouping and document
properties definitions from a workflow that includes the IdentifyPDFDocuments step.

See Working with control files, p. 19 and Previewing markup, p. 20 for tips on using multiple control
files and best practices for verifying where markup prints.

SSaammppllee PPDDFF ffiilleess
If your production PDF files are large (for example, over 1000 pages in length), you should mark up a
smaller sample PDF file that represents the PDF files you process in RICOH ProcessDirector.

You only need to mark up one sample PDF file, save all your changes to control files, and then use
RICOH ProcessDirector to apply those changes to all of your production PDF files that match the sample
PDF file. If you use RICOH ProcessDirector to process several PDF files that have different formats or
different document properties, you need to mark up a sample PDF file for each type of file that you print
using RICOH ProcessDirector. When working with RICOH ProcessDirector Plug-in for Adobe Acrobat,
the goal is to mark up a PDF file that represents your production PDF files but that is smaller than your
production files. If you mark up a PDF file in RICOH ProcessDirector Plug-in for Adobe Acrobat that is
under 1,000 pages, you can work more quickly when adding markup and when using preview and
viewing extracted document properties.

Both your sample PDF file and PDF files processed by RICOH ProcessDirector must contain all fonts and
images in the PDF file itself. If you have PDF files with varying page sizes, markup may not appear as
you expect. The placement reference for all markup, document properties, and page group definitions
is the top left corner of each page.

1 Overview
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22.. Using RICOH ProcessDirector Plug-in for Adobe
Acrobat

•Adding the plug-in icon to the Acrobat quick launch bar
•Preferences
•Units of measure
•User interface
•Working with control files
•Previewing markup
•Modifying markup definitions
•Defining a page group
•Working with document properties
•Working with rules
•Adding markup to a PDF file
•Working with page inserts
•Media and finishing

You use this software to enhance a PDF file by adding markup, such as barcodes, and by defining
document properties using data in the PDF file.

In the RICOH ProcessDirector IdentifyPDFDocuments and BuildPDFFromDocuments steps, you specify
the RICOH ProcessDirector Plug-in for Adobe Acrobat control files that contain the markup and
document properties definitions, to apply the same enhancements in PDF files that you process on
RICOH ProcessDirector.

AAddddiinngg tthhee pplluugg--iinn iiccoonn ttoo tthhee AAccrroobbaatt qquuiicckk llaauunncchh bbaarr
Before you can mark up a PDF file, you must make the plug-in the active tool in Adobe Acrobat.
Clicking the plug-in icon is a convenient alternative to clicking Ricoh→ Select in the menu bar. You
can permanently place the RICOH ProcessDirector Plug-in for Adobe Acrobat icon on the Adobe
Acrobat quick launch bar.

Follow these steps:

1. Open Adobe Acrobat Professional.

2. Click the Tools menu on the far right.

3. Click Advanced Editing.

4. Right-click the RICOH ProcessDirector Plug-in for Adobe Acrobat icon ( ) and select Add to
Quick Tools. The RICOH ProcessDirector Plug-in for Adobe Acrobat icon is permanently placed
in the quick launch bar below the Acrobat main menu.

When the plug-in is the active tool, its icon will be highlighted.

PPrreeffeerreenncceess
You can set preferences for RICOH ProcessDirector Plug-in for Adobe Acrobat to customize it for the
way that you process PDF files.

To change your preferences, click Ricoh→ Preferences.
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Fonts tab

Use the Fonts tab to select the font and size. This font is applied to the name of the markup boxes you
draw in a PDF file. You use this option to change the font of the characters in your preferred language.

• Selections for style, effects, color, and type of script are not applied to the name of the markup
boxes.

Preview tab

Use the Preview tab to set values for these properties:

Pages to Process
This value determines the maximum number of pages to process when you preview markup, export
and view document properties, and use the Page Group Navigator. The more pages you specify,
the longer RICOH ProcessDirector Plug-in for Adobe Acrobat takes to preview markup and view
document properties.

Production Intent
This value defines how RICOH ProcessDirector Plug-in for Adobe Acrobat interprets PDF files. For
example, when the Production Intent is Simplex, Second Front Only page placement puts
markup on the second page of each page group. When the Production Intent is Duplex, Second
Front Only page placement puts markup on the third page of each page group.

Show electronic forms
This value determines whether Preview shows how sample files look when the data is combined with
electronic forms defined for the media that the files use.

Address tab

Use the Address tab to set a value for the Default address block format property. The default value
is displayed when you use the Define Address Block function.

Logging tab

RICOH ProcessDirector Plug-in for Adobe Acrobat provides a log file in text format that you can
customize to provide different levels of historical information. Use the Logging tab to define these
properties:

Logging Level
The types of messages saved in the log file. Trace saves all six types. Info saves four types:
informational, warning, error, and fatal messages. Fatal saves only fatal messages. Off turns off
logging.

Log Output Folder
The directory path for the plug-in and Java log files that the system creates. The directory path must
exist when the system creates the first log file. If a file does not exist, the system creates it.

Plug-in Log File
The file name for the plug-in log file that the system creates.

2 Using RICOH ProcessDirector Plug-in for Adobe Acrobat
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Java Log File
The file name for the Java log file that the system creates.

Maximum File Size
The upper size limit for the log. The minimum file size is 1 MB; the maximum file size is 10 GB.
When the file reaches the upper limit, the system closes the file, renames it to include a number at
the end of the name. The system keeps the file until the value in the Number of Log Files to Retain
property is reached. For example, the log file name is Log.txt. Each renamed file is Log.n.txt,
where n is a number from 1 to the value in the Number of Log Files to Retain property. The most
recent log remains Log.txt.

Number of Log Files to Retain
The number of log files that the system keeps in addition to the current log file. When this limit is
reached, the system deletes the oldest log file after it creates a log file. For example, you select 3.
The system keeps the current log file plus the three most recent log files.

Advanced tab

Use the Advanced tab to set values for these properties:

Port
The internal port number for communication between RICOH ProcessDirector Plug-in for Adobe
Acrobat and its background Java process. Restart Adobe Acrobat for this value to take effect. Edit
this field if you have software that uses the default port.

Heap Size (MB)
The number of megabytes for the desired minimum amount of memory in the Java Virtual Machine
allocation pool. Restart Adobe Acrobat for this value to take effect. Experiment with this value to
tune it to the size and complexity of the PDF files you mark up. When you experience delays while
previewing, selecting text, using the Page Group Navigator, or extracting and exporting document
properties, you might improve performance by increasing the number of megabytes. If you set the
heap size to a value that is greater than the available memory, you might not be able to use RICOH
ProcessDirector Plug-in for Adobe Acrobat. In that case, decrease the heap size value, restart
Adobe Acrobat, and reactivate the plug-in.

Other JVM Options
In addition to setting the minimum heap size, you can fine-tune other JVM memory settings. Edit this
field only on the advice of your support representative.

UUnniittss ooff mmeeaassuurree
RICOH ProcessDirector Plug-in for Adobe Acrobat uses the units of measure from the Pages & Ruler
Units you set in Adobe Acrobat preferences.

To see or change this setting, click Edit→ Preferences→ Units & Guides.

You define certain units of measure, such as those for the OMR marks, when you define the markup.

Units of measure
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UUsseerr iinntteerrffaaccee
The plug-in user interface consists of the Ricoh menu added to Adobe Acrobat, a right mouse button
popup menu, a left mouse button popup menu, and windows that you use to perform RICOH
ProcessDirector Plug-in for Adobe Acrobat functions.

Ricohmenu and right mouse button popup menu

The Table Ricoh and right click menu options, p. 16 describes the options you can select from the Ricoh
menu that is added to the Adobe Acrobat Pro menu bar and when you right click in a PDF file.

Ricoh aanndd rriigghhtt cclliicckk mmeennuu ooppttiioonnss

Menu Option Description

Select Makes RICOH ProcessDirector Plug-in for Adobe Acrobat the active Adobe
Acrobat tool. After activating the plug-in, you can use the left mouse button
to draw a box in an area of the PDF file where you want to select specific
text or add markup.

Add Markup Displays the options on the left-mouse button menu.

View Markup
Navigator

Displays a list of the markup, document property, and page group
definitions that have been added to the active PDF file. You can use this view
to edit markup and to locate markup that is hidden under other markup.
Mark the check box next to a name in the list to display the box for that
markup. Remove the check to hide the markup box. If you deselect the
check box in front of a markup type, you hide the boxes for all markup of
that type.

View Page Group
Navigator

Views the pages that belong to each page group. Click the + sign to
expand the page groups and click the − sign to collapse the page groups.
You can also use this view to navigate to specific pages in the PDF file. Click
one of the pages in a page group to make that the active page in Adobe
Acrobat.

If you do not see the page groups you were expecting based on your page
group definition, you must edit the definition to obtain the correct page
groups. If you do not see the correct page groups in this view, you cannot
obtain correct print results in RICOH ProcessDirector.

Preview Verifies that files are going to print as you expect when your markup,
media, and finishing are applied to a job. After you have examined the
preview rendering of the PDF file, click X in the upper right corner of the PDF
file to close the rendered PDF file and to return to your original PDF file.

Preview Preferences Sets or changes preview preferences. You can define: the maximum number
of pages to process, the rendering intent, and other settings.

View Document
Property Values

Views the values of the document properties that are defined in the loaded
control file. You can save the values to a tab-delimited text file.

Manage Rules Displays your conditional processing rules. You can define new rules, and
you can edit or delete existing rules.
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Menu Option Description

Manage Inserts Inserts pages from other PDF files before each document that matches the
placement conditions, after each document that matches the placement
conditions, or both. The inserted pages increase the number of pages in
each document, and you can apply markup to them.

Media and Finishing Defines media and finishing options for a range of a pages or for the
documents within your PDF file.

Load Control File Loads an existing control file. RICOH ProcessDirector Plug-in for Adobe
Acrobat saves all page group, document property, and markup definitions
into one or more control files. If you load a control file, you load all
definitions in that control file. You can only have one control file loaded at a
time.

Save Control File Stores any markup, document property, and page group definitions to a
control file. The Save Control File window displays the name and location of
the control file you are saving. You can enter a new name for the control
file, or keep the existing name to overwrite the control file you previously
loaded or saved. Whenever you save a control file used by RICOH
ProcessDirector, you must copy the control file to the location you define in
the control file properties in the RICOH ProcessDirector
BuildPDFFromDocuments or IdentifyPDFDocuments step.

Clear Markup Removes all markup, document property, and page group definitions from
the active PDF file. You use this option when you want to start over or create
a new control file that does not contain any of the markup from the prior
control file. If, after using this option, you add markup or other definitions to
the PDF file, you use the Save Control File option and save the definitions
with a new control file name.

Preferences Sets or changes preferences, such as the default font used for the labels for
the markup you add to a PDF file; the maximum number of pages to
process; the rendering intent; logging options; and the maximum amount of
memory (heap space) to reserve for RICOH ProcessDirector Plug-in for
Adobe Acrobat.

Help Opens the publication RICOH ProcessDirector: Using RICOH ProcessDirector
Plug-in for Adobe Acrobat.

About Displays the version information for your RICOH ProcessDirector Plug-in for
Adobe Acrobat installation.

Left-mouse button menu

The Table RICOH ProcessDirector Plug-in for Adobe Acrobat left mouse menu, p. 18 describes the
options you can select from the RICOH ProcessDirector Plug-in for Adobe Acrobat menu that you see
when you use the left mouse button to draw a box in the PDF file. To use the left mouse button, you must
first make RICOH ProcessDirector Plug-in for Adobe Acrobat the active tool in Adobe Acrobat by either
clicking the plug-in icon or by clicking Ricoh→ Select. You draw a box in a PDF when you want to
select text or define an area to place markup. To draw a box, click the left mouse button, and without
letting go of the mouse button, drag the cursor down and to the right until you have either selected the
text you want or have drawn a box the size that you want. When you release the mouse button, a menu
pops up with the following options.

User interface
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RRIICCOOHH PPrroocceessssDDiirreeccttoorr PPlluugg--iinn ffoorr AAddoobbee AAccrroobbaatt lleefftt mmoouussee mmeennuu

Menu Option Description

Define Page Group Defines a page group to break a PDF file into mailpieces, such as
statements or invoices. You must define the page group before you add
markup or define document properties.

Define Conditional
Trigger

Defines a conditional trigger from text in the PDF. You use a conditional
trigger in a conditional placement rule that defines the pages on which
markup is printed or document properties are extracted. For example, you
want to add a QR barcode only on the page where the word Invoice
occurs near the top left of either the first or second page of a statement. You
first define the word Invoice as a conditional trigger. Then, when you are
defining the QR barcode, you select that trigger as a conditional placement
rule on the QR barcode so it only prints on the pages where the word
Invoice occurs in the location you selected.

Define Document
Property

Defines existing data in your sample PDF file as a document property so
RICOH ProcessDirector can use that data in different steps (such as adding
barcodes). After you define document properties, you can later search for
them in the RICOH ProcessDirector viewer for reprint and other actions.

You can also define a document property on any text or DataMatrix
barcode that you want to extract from the PDF file. In that case, you do not
select a standard RICOH ProcessDirector document property; instead, you
provide your own name for the property.

Define Multiple
Properties

Defines document properties from a block or multiline section of text.

Define Address Block Defines document properties for an address block.

Hide Area Creates a cover block to hide content in a PDF file. Hidden content does not
print and is not viewable in RICOH ProcessDirector Plug-in for Adobe
Acrobat preview or in the PDF viewer in RICOH ProcessDirector. You can
hide an area and then place other markup over the hidden area.

Add Barcode Adds and configures a barcode. First you select the area where you want to
place the barcode. Then, you select a barcode type and add content.
When adding a barcode for downstream processing of mailpieces, you
must understand the precise optical marks required by your machinery and
have configuration specifications from your supplier.

Add OMR Adds and configures optical markings to help manage downstream
processing of mailpieces in the PDF file. When adding an OMR, you must
have an understanding of the precise optical marks required by your
machinery and have configuration specifications from your supplier.

Add Image Adds an RGB JPEG-formatted image to create new content or to cover
existing content.

Add Text Adds text to any location in a PDF file. You designate the area where you
want the text to print and select content from a combination of options,
including typing text.
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WWoorrkkiinngg wwiitthh ccoonnttrrooll ffiilleess
As you use RICOH ProcessDirector Plug-in for Adobe Acrobat to mark up a PDF file, instead of saving
markup in the PDF file itself, you save markup to one or more control files. RICOH ProcessDirector Plug-
in for Adobe Acrobat uses a control file to extract data, and RICOH ProcessDirector uses control files in
the different stages of preparing a PDF file for printing.

You use the Ricoh menu options Load Control File and Save Control File to manage control files. You
can only have one control file loaded at a time. When you finish marking up a PDF file, you save the
control file to a directory accessed by RICOH ProcessDirector. You configure RICOH ProcessDirector
workflows with one or more step templates that use RICOH ProcessDirector Plug-in for Adobe Acrobat
control files.

• Do not manually edit RICOH ProcessDirector Plug-in for Adobe Acrobat control files without advice
from a Ricoh support representative.

• RICOH ProcessDirector Plug-in for Adobe Acrobat Version 3.6 includes an improved PDF
processing library. For most PDF files, the new library improves performance, reduces processing
time, and uses less memory.
When you open a control file created in a previous release, RICOH ProcessDirector Plug-in for
Adobe Acrobat prompts: Do you want to update your control file to use an improved PDF
processing library?

If you click No, the message appears the next time that you open the control file.

If you click Yes, RICOH ProcessDirector Plug-in for Adobe Acrobat updates the control file, and the
message never appears again.

When you update a control file, make sure that it produces the same results. Slight differences
between libraries could result in slightly different text selection boxes. A smaller box could exclude
text that you want to select, and a larger box could include text that you do not want. Using the
improved library also could change the position of markup slightly.

No other changes are required on the RICOH ProcessDirector server to use the improved PDF
library.

• To use a control file built for a PDF 1.7 file with a PDF 2.0 file, you must update the control file to
use the new library.

You must save any page group definitions and document properties to a single control file. You can add
markup, media, and finishing definitions to that single control file, or you can separate the definitions
into different control files. You specify the control file that defines page groups and document properties
in a step based on the IdentifyPDFDocuments step template. The control files that define markup,
media, and finishing must be specified in a step based on the BuildPDFFromDocuments step. When
you decide whether to create one or more control files, take your print environment into account: the
complexity of your changes, how you want to differentiate your markup, and what PDF file
enhancements change most often.

In a repetitive print environment where your PDF workflow does not change often, you could choose to
create only one control file. When you preview a PDF file to verify where markup is going to print and
which pages have media and finishing options, you can view all markup, media, and finishing in one
view. You move the single control file to a directory accessed by RICOH ProcessDirector. You define the
control file name and location in both the IdentifyPDFDocuments and the BuildPDFFromDocuments
steps.

Working with control files



2

20

You could also use one control file when you want to preview the PDF file to make sure that all markup,
media, and finishing are applied correctly. When you preview a file, RICOH ProcessDirector Plug-in for
Adobe Acrobat renders markup and applies media and finishing options that are defined in the active
PDF file. You cannot use preview to verify markup, media, and finishing definitions in a control file that is
not loaded.

You could choose to use more than one control file in an environment that changes frequently or
unexpectedly. By using different types of control files, you can mitigate the risk of change or adapt to it
quickly. For example:

• The page group definition is less likely to change than other definitions in your PDF files. You can put
the page group and document property definitions in the control file that you add to the
IdentifyPDFDocuments step.

• You have installed the Inserter feature, and you switch between inserters. You do not have to edit
your workflow each time you switch. Instead, you save the barcode markup for each inserter in a
separate control file with a name that identifies the inserter. In the BuildPDFFromDocuments step,
you specify the name and location of one control file, using symbol notation that matches the value
of a job property. During print processing, you set the value of that job property to the name of the
control file that matches the inserter you want to use for the job.

Symbolic notation also lets you use the same workflow for input files that need different RICOH
ProcessDirector Plug-in for Adobe Acrobat control files. For example, you have two input files, File1.
pdf and File2.pdf, with corresponding control files, File1.ctl and File2.ctl. You want to use the
same workflow for both files. You can use ${Job.InputFile}.ctl as the control file name that you
specify in the BuildPDFFromDocuments step. ${Job.InputFile}.ctl causes RICOH
ProcessDirector to set the value of the RICOH ProcessDirector Plug-in for Adobe Acrobat control file
property to the name of the input file plus the .ctl extension.

PPrreevviieewwiinngg mmaarrkkuupp
After you add markup to a sample PDF file, you can preview markup placement. Previewing lets you
verify that PDF files are going to print as expected when RICOH ProcessDirector applies the markup that
you saved to a control file. Preview also lets you verify that media and finishing options are going to be
applied to the intended pages.

Using preview with more than one control file

If you save more than one control file for markup, media, and finishing definitions, preview renders only
the definitions contained in the loaded control file. For example, you save a barcode definition in a
control file called barcodes.ctl and an image definition in images.ctl. You can have either
barcodes.ctl or images.ctl loaded in RICOH ProcessDirector Plug-in for Adobe Acrobat. If you
have barcodes.ctl loaded, you preview the placement and content of the barcode, but you cannot
preview the image because you do not have images.ctl loaded.

You can include page group and document property definitions in any control file. If a page group is
defined in a control file that is not loaded, you cannot preview markup, media, and finishing with
conditional placement rules based on page groups. If document properties are defined in a control file
that is not loaded, you cannot select those document properties as content for markup. If you want to
preview as much markup as possible while using multiple control files, first save page groups and
document properties to a control file, for example, pagegrouping.ctl. When you are ready to define
markup, load pagegrouping.ctl, add the markup, and save the result to a new control file (for
example, barcodes.ctl). To define more markup and save it to a separate control file, first load
pagegrouping.ctl. Add the markup (for example, images), and save the result to a new control file
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(for example, images.ctl). By starting your markup definitions from a control file that contains page
groups and document properties, you can preview markup, media, and finishing that use conditional
placement rules and document properties.

If you save all your enhancements in one control file, you can preview all markup, media, and finishing
at once.

• You cannot edit, print, or save a preview file.

• You must define a page group before you can preview markup. For more information, see Defining
a page group, p. 23.

• The Pages to Process preference specifies the maximum number of pages that Preview processes.
The greater the Pages to Process value, the longer RICOH ProcessDirector Plug-in for Adobe
Acrobat takes to preview markup added to a PDF file. For more information, see Preferences, p. 13.

• The Production Intent preference determines how RICOH ProcessDirector Plug-in for Adobe
Acrobat interprets PDF files. For more information, see Preferences, p. 13.

• The Show electronic forms preference determines whether Preview shows how sample files look
when the data is combined with electronic forms defined for the media that the files use.

• When you define markup in a PDF file, you can use the values of job and document properties as
content for markup and in conditional placement rules. Preview uses values that are extracted from
the PDF file. If you have markup that uses job or document properties that are not defined in the file,
RICOH ProcessDirector Plug-in for Adobe Acrobat uses a unique static numeric value for each job
or document property. If conditional placement rules use properties that are not defined in the file,
usually Preview always applies or never applies markup based on those rules.

• If your markup uses an image that the plug-in cannot find (for example, an image that is not on your
local machine), preview does not render the image. Instead, preview places a message that
specifies the name of the missing image in the location specified for the image.

• You cannot preview markup that is placed using a RICOH ProcessDirector Plug-in for Adobe
Acrobat rule that evaluates Stat.CurrentMedia.

To preview markup:

1. Click Ricoh→ Preview.

RICOH ProcessDirector Plug-in for Adobe Acrobat generates and displays a new, temporary PDF
file. Your sample PDF file remains open.

The temporary PDF file opens to the first page regardless of the page you are editing in the
sample PDF file.

2. When a page has media and finishing options, you see an annotation labeled Print Operations
in the upper right corner. To see the media name and finishing option, hover the mouse pointer
over Print Operations.

As an alternative, click Comment on the Adobe Acrobat toolbar. In the Comments pane, you
see a comment for each page with media and finishing options.

3. If electronic forms are defined for media used by sample files, you can see how the files look
when the data is combined with the forms.

To see the electronic forms:

Previewing markup



2

22

• Make sure that you exported the RICOH ProcessDirector media.zip file and loaded it to the
correct directory on the system where you installed RICOH ProcessDirector Plug-in for Adobe
Acrobat. For more information about loading media objects to the plug-in, see the help
system or Ricoh ProcessDirector: Installing Document Processing Features.

• For pages in your sample PDF file, select media that defines electronic forms. As an
alternative, load a control file that you saved after selecting media that defines electronic
forms.

• Make sure that the Show electronic forms preference is set to Yes.
Although Preview lets you see how files look when the data is combined with the forms, the
data and forms remain separate. RICOH ProcessDirector combines the forms with the data in
production PDF files when the CombinePDFWithForm step processes the files.

4. When you have finished previewing the PDF file, you can close this temporary PDF file or leave it
open.

You can update the temporary PDF file by clicking Ricoh→ Preview.

MMooddiiffyyiinngg mmaarrkkuupp ddeeffiinniittiioonnss
After you add markup to a PDF file, you might need to delete the markup, move it to a new location, or
modify its properties. RICOH ProcessDirector Plug-in for Adobe Acrobat provides several ways to edit
and delete markup, document properties, and a page group definition.

The most common methods to edit markup are to double-click the box you drew to display the markup
definition window or to click a box and move it to a new location. But you may have layered markup
under other markup, such as having several barcodes in the same area because you want to print only
one based on RICOH ProcessDirector conditional processing. You could also place a hidden area over
an image and place a smaller image over the hidden area. To edit markup layered under other
markup, you can use the Markup Navigator to select the markup you need to edit.

Tip: Keep in mind that changes you make to markup in the active PDF file must be saved to the control
file to which you previously saved the markup definition. For example, if you added a barcode to a PDF
file and saved that definition to a control file, and you delete the barcode from the active PDF file, you
must save that change to the existing control file. After you save markup changes to a control file, you
must make the new version of the control file accessible to a RICOH ProcessDirector server for those
changes to be applied to your production PDF files.

You can use any of the following methods to edit markup.

MMeetthhooddss ttoo mmooddiiffyy mmaarrkkuupp

Method Description

Double-click a
markup box

Displays the property definition window for the markup box.

Right-click a
markup box

Displays a popup menu with options to edit the definition of the markup box or to
delete it.

Click and
drag to resize
or move a
box

Click any box for markup, document properties, or a page group definition. Resizing
handles appear on the corners of the box. Click and drag a corner to change the
size of the box.

Click and drag the middle of a box to move it to a new location.

2 Using RICOH ProcessDirector Plug-in for Adobe Acrobat



2

23

Method Description

• If the markup is layered underneath other markup, click Ricoh→ View Markup
Navigator to isolate the markup you want to resize. Remove the checkmark
from the boxes in front of markup that blocks your access to the markup you want
to edit.

• You can use the horizontal and vertical coordinates, width, and height in the
markup definition window to change the location and size of the markup box.

• If you click, resize, or move either a page group definition or a conditional
trigger, make sure it is on the page that contains the data you are looking for.
These three actions resample the data for a page group definition or a
conditional trigger. If you do one of the actions on the wrong page, RICOH
ProcessDirector Plug-in for Adobe Acrobat asks whether it should accept your
change. If you click OK, the data changes to an incorrect value.

Left-click in the
Markup
Navigator

To highlight a markup box:

1. Click Ricoh→ View Markup Navigator.

2. Click the markup you want to highlight.

Tip: You can keep the Markup Navigator window open as you add, modify, and
delete markup. The window automatically updates with your changes.

Double-click
in the Markup
Navigator

To edit markup, document properties, or a page group definition:

1. Click Ricoh→ View Markup Navigator.

2. Double click the markup you want to edit.

Hide markup
using the
Markup
Navigator

To hide markup, document properties, or a page group definition so you can access
other markup:

1. Click Ricoh→ View Markup Navigator.

2. Toggle the check box on and off to show and hide:
• A box that you drew for markup, document properties, or a page group

definition.
• A group of markup. For example, remove the check from the Image check

box to hide all image markup boxes.

When you use the Markup Navigator to hide markup, you are only hiding it from
your view of the active PDF file. If you have a control file that contains hidden
markup and you save a control file, the hidden markup is saved to the control file,
and any definitions in it are processed by RICOH ProcessDirector.

DDeeffiinniinngg aa ppaaggee ggrroouupp
A page group defines the pages ranges for each document in your PDF file. You save one page group
definition to the control file that you specify in a RICOH ProcessDirector IdentifyPDFDocuments step. We
recommend that you define a page group before you add markup.

Defining a page group
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You can define more than one control file per PDF file, but only the control file you identify in the
Identify PDF control file property of the step based on the IdentifyPDFDocuments step template
creates page groups. If you want to use RICOH ProcessDirector Plug-in for Adobe Acrobat preview
mode to verify the correct placement of other markup, you might need to define a page group in the
control files you use to generate such markup. You can, for example, add a control file that contains
page group definitions to a BuildPDFFromDocuments step. However, because a
BuildPDFFromDocuments step receives page grouping information from the previous
IdentifyPDFDocuments step, a BuildPDFFromDocuments step ignores any page group definitions in its
control files. See Previewing markup, p. 20 for more information about best practices.

To define a page group:

1. Open a PDF file in Adobe Acrobat Professional and click Ricoh→ Select to make the plug-in the
active tool.

2. To define a text-based page group, draw a box around the target text. Otherwise, draw a box
anywhere on the page.

3. Click Define Page Group.

4. Either accept or change the default page group name. We recommend that you use the default
name, so that anyone working on the PDF file can easily see where the page group boundary is
defined. If you do change the name, do not use spaces or special characters (such @, #, $, and
%). You can use periods and underscores.

5. For text-based page groups, you can alter the location and size of the enclosing box by entering
values for Horizontal and Vertical coordinates,Width, and Height. The position and size of
the box are adjusted after you click OK.

6. From the Page Groups list, select one of these options:

• Treat entire PDF as a single page group: Creates a single page group that includes all
processed pages.

• Create fixed-length page groups: Creates page groups of specific lengths based on the
value of the Page Group Length property. Page grouping starts on page 1 of the PDF file.
For example, select 5 to create page groups for pages 1–5, 6–10, 11–15, and 16–18 in
an 18–page PDF file.

• Begin page group when the selected text is found: Creates page groups based on text
that you select. Any page with the selected text inside the box you drew becomes the first
page of a new page group.
For example, select Page 1 of to create a new page group each time that RICOH
ProcessDirector Plug-in for Adobe Acrobat finds the text Page 1 of inside the box you drew.

Characters in a PDF file have white space enclosing them. Make sure that the Selected Text
field does not include characters — such as white-space characters — that you do not want. If
it does, cancel the page group definition and redraw the box around the text.

• Begin page group when the specified text is found: Creates page groups based on text
that you specify. Any page with the specified text inside the box you drew becomes the first
page of a new page group. The text does not need to be on the same page as the box you
drew.
From theMatch method list, select one of these options:
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– Match text exactly: Matches the exact text that you specify.

– Match text containing: Matches the text that you specify to a portion of the text in the
box you drew. The text that you specify does not need to be in the same location on each
page.

For example, use this option to create a new page group each time that RICOH
ProcessDirector Plug-in for Adobe Acrobat finds the text Page 1 of anywhere inside the
box you drew. The box can contain other text. Page 1 of 4 and This is Page 1 of 4
found in the box both match the specified text Page 1 of.

– Match text using wildcards [* or ?]: Matches the text that you specify, which includes
wildcard characters, by interpreting the wildcard characters as any characters. The
asterisk (*) matches zero or more characters. The question mark (?) matches a single
character.

For example, the first page of each mail piece has an account number that starts with A
followed by seven digits. The position of the account number varies on each statement.
You draw a box large enough to include the account number on all the statements and
type A??????? as the value of the Specify text to match property. RICOH
ProcessDirector Plug-in for Adobe Acrobat starts a new page group on each page with
an account number like A1265581 or A6428229.

If you typed A??????* as the value of the Specify text to match property, RICOH
ProcessDirector Plug-in for Adobe Acrobat would start a new page group when it finds
account numbers with six or more digits.

– Match text using a Java regular expression: Matches the Java regular expression
that you specify.

For example, each mail piece is in one of two languages: English or Spanish. You type
(Page 1 of).*|(Página 1 de).* as the value of the Specify text to match property.
RICOH ProcessDirector Plug-in for Adobe Acrobat starts a new page group when the text
found is Page 1 of followed by any number of characters or Página 1 de followed by
any number of characters. Examples: Page 1 of, Page 1 of 6, Página 1 de 2, or Página
1 de 10.

For more information, see the Java documentation for the java.util.regex.Pattern class.

• Begin page group when text in selected area changes: Creates page groups when text
inside the box you drew changes. The page with the changed text becomes the first page of
a new page group.
For example, you draw a box around an account name. RICOH ProcessDirector Plug-in for
Adobe Acrobat creates a page group each time a new account name appears in the box
you drew.

When you draw the box for this type of page group, make sure that the location of the box
on every page encompasses only the text to evaluate or white space (no text). If other text
appears in the box, unwanted page groups are identified. Pages that contain white space, in
the location of the box, do not start a new page group.
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• Begin page group when text or drawn objects are detected: Creates page groups
when either a graphic object or text is enclosed in the box you drew. If the box you drew
does not contain the text or entire graphic, then the page is not the start of a new page
group.

Not all marks are graphics. Some marks are image data.

7. Click OK.

8. Click Ricoh→ View Page Group Navigator and verify that the page groups begin on the
correct pages.

If text-based page groups do not begin on the correct pages, the box you drew might not be the
correct size for the text you selected or specified. Inspect the page groups to see if you can find
the problem. Then redraw the box, change the text, or both.

9. Edit the page group definition by double-clicking the box representing the page group, or by
clicking Ricoh→ View Page Group Navigator and then double-clicking the page group
name.

10. When you are ready to save all your enhancements to the PDF file, including the new page
group definition, click Ricoh→ Save Control File.

WWoorrkkiinngg wwiitthh ddooccuummeenntt pprrooppeerrttiieess
You can define document properties from data in your PDF file that you want to use for later print
processing. When RICOH ProcessDirector processes PDF files with document property definitions, it
extracts, or mines, values from each page group in a PDF file. For example, you can create document
properties to extract data in each page group in a PDF file and define that data as the content of a
barcode that prints on a page in the same page group.

When you define a document property, you specify data in the PDF file. You can apply conditional
processing rules to tell RICOH ProcessDirector Plug-in for Adobe Acrobat and RICOH ProcessDirector
where to extract the data from and when to extract it. For example, you want to apply conditional
processing rules that extract an account number from the first page of every page group when an
account is overdue. First you create a conditional trigger on text that indicates the account is overdue.
Then you define a rule with two conditions. One condition specifies that the “overdue” text is present.
The other condition specifies the pre-defined rule First Front Only. You choose to apply the new rule
when all of its conditions are met. Finally you define the account number as a document property and
select the new rule in the Placement Conditions section. RICOH ProcessDirector Plug-in for Adobe
Acrobat and RICOH ProcessDirector extract the account number from the first front page of each page
group when the “overdue” text is present.

When you define a document property in RICOH ProcessDirector Plug-in for Adobe Acrobat, you select
a RICOH ProcessDirector document property from a list or define your own document property name. If
you define your own document property name instead of selecting a RICOH ProcessDirector document
property, that document property cannot be integrated into RICOH ProcessDirector functions that save
the properties to the database. You cannot use that document property for functions in RICOH
ProcessDirector document processing features, or for markup content in barcodes or text. You should
choose to create your own document property in RICOH ProcessDirector Plug-in for Adobe Acrobat
only if you are going to extract your document properties to a file or if you know the document property
will exist in RICOH ProcessDirector when your PDF files are processed. If you need to use a document
property with RICOH ProcessDirector, create it in RICOH ProcessDirector and then select the document
property from the list in RICOH ProcessDirector Plug-in for Adobe Acrobat.
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• You see the database or system names for document properties in the lists in RICOH ProcessDirector
Plug-in for Adobe Acrobat and the document properties list in the RICOH ProcessDirector viewer. In
those lists you do not see custom or translated document property names.

Viewing document property values

After you define one or more document properties, you click Ricoh→ View Document Property
Values to see the values of the document properties in the active PDF file. You can verify that the
conditional processing rules and the text selected for each document property are correct. Use the
document property view to verify that none of the document property values are longer than the text
selection box you drew. RICOH ProcessDirector Plug-in for Adobe Acrobat truncates any text that
extends beyond the text selection box.

• The Document Property window is a useful tool for you to keep open as you define document
properties. After you create your first document property and view its values, you can click the
Update Table button in the Document Property window at any time to update the table with
changes that you made to the document properties.

Saving document property values

If you need to use document property values outside the product, click Save while viewing document
property values. RICOH ProcessDirector Plug-in for Adobe Acrobat saves the values to a tab-delimited
text file.

Using document properties in RICOH ProcessDirector

You define how document properties are used in different RICOH ProcessDirector print processing
steps. For example, you define how RICOH ProcessDirector uses document properties in its barcode
creation function. You can also use document property values to search for a specific customer account
from a PDF print job if you need to reprint a mailpiece of that one customer.

Creating new document properties in RICOH ProcessDirector

After you install your document processing feature, you define all of the custom document properties
you need in the docCustomDefinitions.xml file. When you run the docCustom utility to update
configuration files, those properties are added to the database. If you need to create additional custom
document properties, you edit the docCustomDefinitions.xml file and rerun the docCustom utility.

• If you use custom document properties, starting with Version 3.11.2, you can create them on the
Administration tab, using Objects→ Custom Properties.
You can choose the database name and the label that displays in property notebooks and column
headings. You can also choose what kind of data to store in the property, and the default access
that the different user groups have for the property, without adding them to the
docCustomDefinitions.xml file.

• If you already have custom document properties defined in a docCustomDefinitions.xml file,
you can continue to use them. Do not re-create them from the Administration tab. Only use that tab
to create new job or document properties.
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After you load the new document properties values, they are available to you in the plug-in wherever
you define document properties. For more information about editing the docCustomDefinitions.xml
file and running the docCustom utility, see RICOH ProcessDirector: Installing Document Processing
Features.

• When you define document properties you can define a document property as a limited document
property. Limited document properties do not need database table space; however, they occupy
space for each document in each document properties file that contains the property.

Defining a document property

RICOH ProcessDirector features can store document property values in the RICOH ProcessDirector
database. The features rely upon document properties for later downstream processing of PDF files in
RICOH ProcessDirector.

• Read the document property overview section to ensure you understand how document properties
are used in RICOH ProcessDirector so you can take full advantage of your RICOH ProcessDirector
feature.

To define a document property:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group definition or define a page group.

2. Left-click just above the top left corner of the data that you want to capture. Drag the mouse to
draw a box around the data.

You can later view the extracted values to verify your selection.

• The data to capture can be text or DataMatrix barcodes encoded as images.

• Make the box big enough to capture the longest occurrence of the data in your PDF files.
Some characters in a PDF file have a larger white space buffer than other characters. For
example, the left edge of a large capital letter might have up to a tenth of an inch of white
space buffer that you might need to select in order to capture that letter.

3. Select Define Document Property from the popup menu.

4. Select a RICOH ProcessDirector document property from the list or type a document property
name into the field. Do not use any special characters (such as @, #, $, %, or - (dash)) or spaces.
The RICOH ProcessDirector IdentifyPDFDocuments step might fail. You can use periods and
underscores.
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• When you define document properties, you can define a document property more than once.
For example, text in your PDF file might be variable, and you might need to mine the zip code
from two different locations. You can define your zip code document property twice - as long
as you define different conditional placement rules that specify the pages from which the
property is extracted. If you define the same document property in two different ways in the
document, and each of their conditions are met, then only the value extracted last is used.

5. Define which type of data to extract values from.

• If you selected an area that only contains text, select Text under Select from.

• If you selected an area that only contains barcodes, select Barcode image under Select
from.

• If you selected an area that contains both text and barcodes, select both Text and Barcode
image.
The text data is placed before the barcode data in the extracted string without an indicator of
where the text data ends and the barcode data begins.

– We recommend using black barcodes. Using colored barcodes might have unpredictable
results.

6. Specify the page in each document from which document property data will be extracted. Do
either of these:

• Select Pages based on a rule, and then select a rule from the drop-down list. The default
rule is First Front Only. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

– The Last Back, Last Front, and Last Page rules do not work with the extraction of
document property data.

• Select Specific pages and type the page in each document that you want.
If you specify multiple pages, RICOH ProcessDirector Plug-in for Adobe Acrobat extracts the
document property data from the last specified page in each document. Examples:

– You specify pages 2–4. If a document has four or more pages, the document property
data is extracted from page 4. If a document has three pages, the document property
data is extracted from page 3. If a document has two pages, the document property data
is extracted from page 2.

– You specify pages 2,4. If a document has four or more pages, the document property
data is extracted from page 4. If a document has 2–3 pages, the document property
data is extracted from page 2.

– You specify pages 2–n. Because n represents the last page, the document property data
is extracted from the last page if the document has two or more pages.
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♦ If you specify only page n, RICOH ProcessDirector Plug-in for Adobe Acrobat does
not extract the document property data from any page in a document.

7. OOppttiioonnaall:: Select the edit icon ( ) to display a Modify Text window where you define one or
more modifier extraction rules to extract the exact document property you need.

1. Choose one of the following modifiers:

CCoonntteenntt mmooddiiffiieerrss

Modifier Action

Remove Character Type one character or a blank character (use the space bar to
type a blank character) that you want to remove from the
value. The character is case-sensitive. Then select one of these
buttons:
• Remove all instances of the character

The specified character is removed from all positions in the
value.

For example, an account number is: 324-1443255-11.
You can type a - to remove all - characters from the value,
producing 324144325511.

• Remove leading characters
The specified character is removed from the beginning of
the value. For example, if you type a blank character, all
blank characters are removed from the beginning of the
value.

• Remove trailing characters
The specified character is removed from the end of the
value. For example, if you type a blank character, all
blank characters are removed from the end of the value.

• Remove leading and trailing characters
The specified character is removed from the beginning and
end of the value. For example, if you type a blank
character, all blank characters are removed from the
beginning and end of the value.

Substring by Position Select Beginning of Line or End of Line from the Starting
From list. Select a number for First Position to indicate the
location of the first character in the text value. Select a number
for Number to Retain to indicate how many characters are
retained.
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Modifier Action

Substring by Delimiter Type a character or a blank character in the Delimiter field to
indicate where the text value is split into separate string
segments. The character and the text string are case-sensitive.

Select Beginning of Line or End of Line from the Starting
From drop-down menu.

Select a number for First Position to define the position of the
delimiter in the text string.

Select a number for Number to Retain to define the number
of text string segments to retain.

These examples show how to select text string segments by
specifying a delimiter:
• For the account number 324-1443255-11, you can use -

as the delimiter to split the value into these three text strings:
324, 1443255, and 11. Select Beginning of Line. To
select the second and third text strings (1443255 and 11),
select 2 for both First Position and Number to Retain.

• For the mailing address Eldorado Springs CO 80025, you
can use a blank character as the delimiter to split the value
into these four text strings: Eldorado, Springs, CO, and
80025. Select End of Line.

– To select the zip code, select 1 for both First Position
and Number to Retain.

– To select the state, select 2 for First Position and 1 for
Number to Retain.

– To select the city, select 3 for First Position and 10 for
Number to Retain. By specifying 10 for Number to
Retain, you can select city names with up to ten words.

Pad with Character Select Beginning of Line or End of Line from the Padding
Location list. Enter a character or a blank character as the
padding character into the Character to Pad with field.

Enter a number in theMinimum Padded Text Length field to
define the minimum length of the text string. If the number of
characters in the text string is less than this minimum length,
padding characters are added until the text string equals the
minimum length.

When you use a modifier to define a text extraction rule, the Text to Modify field at the top
of the Modify Text window contains the selected line plus any edits you make to the line. The
Modified Value field to the right of a modifier displays the text that results when that modifier
is applied to the text it received from either the modifier above it or the Text to Modify field
(if you are defining the first modifier).
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2. Continue to apply modifiers until you extract the value you want from the selected line. Click

the icon to add a new modifier. The Final Text field below the list of modifiers displays
the final modified value, after all modifier extraction rules are applied.

For the selected modifier, theModifier Initial Text field at the bottom of the window displays
the value before the modifier is applied. TheModified Text field displays the value after the
modifier is applied.

3. Use the modifier management icons near the top of the window to delete and reorder the

modifier extraction rules. Use the icon to delete the selected modifier extraction rules. Use
the up and down arrow icons to reorder the rules. The rules are applied to the line in order
from top to bottom.

4. Click the OK button to save the line extraction rule.

8. Click OK to create the document property.

9. Click Ricoh→ View Document Property Values and scroll through several documents in your
PDF file to verify that RICOH ProcessDirector Plug-in for Adobe Acrobat is extracting the correct
document property values for each document.

10. When you are ready to save all your enhancements to the PDF file, including the new document
property definition, click Ricoh→ Save Control File.

11. In the RICOH ProcessDirector IdentifyPDFDocuments step, specify the name and location of the
control file that contains the document property definition.

Defining multiple document properties

You can define multiple document properties in a block of data in a PDF file. A block of data can be
text, DataMatrix barcodes encoded as images, or both.

• Read the document property overview section to ensure you understand how document properties
are used in RICOH ProcessDirector so you can take full advantage of your RICOH ProcessDirector
feature.

To define multiple document properties:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group definition or define a page group.

2. Left-click just above the top left corner of the block of data that you want to capture. Drag the
mouse to draw a box around the block of data. You can later view the extracted values to verify
your selection.

• Make the box you draw big enough to capture the longest occurrence with the most lines of
data in your PDF files. Some characters in a PDF file have a larger white space buffer than
other characters. For example, the left edge of a large capital letter might have up to a tenth
of an inch of white space buffer that you might need to select in order to capture that letter or
line.
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3. Select Define Multiple Properties from the popup menu.

4. Type a Name for the block of multiple document properties. Do not use spaces or special
characters (such as @, #, $, %, or - (dash)) in the name. You can use periods and underscores.

5. Define which type of data to extract values from.

• If you selected an area that only contains text, select Text under Select from.

• If you selected an area that only contains barcodes, select Barcode image under Select
from.

• If you selected an area that contains both text and barcodes, select both Text and Barcode
image.
The text data is placed before the barcode data in the extracted string without an indicator of
where the text data ends and the barcode data begins.

6. Specify the page in each document from which document property data will be extracted. Do
either of these steps:

• Select Pages based on a rule, and then select a rule from the list. The default rule is First
Front Only. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

– The Last Back, Last Front, and Last Page rules do not work with the extraction of
document property data.

• Select Specific pages and type the page in each document that you want.
If you specify multiple pages, RICOH ProcessDirector Plug-in for Adobe Acrobat extracts the
document property data from the last specified page in each document. Examples:

– You specify pages 2–4. If a document has four or more pages, the document property
data is extracted from page 4. If a document has three pages, the document property
data is extracted from page 3. If a document has two pages, the document property data
is extracted from page 2.

– You specify pages 2,4. If a document has four or more pages, the document property
data is extracted from page 4. If a document has 2–3 pages, the document property
data is extracted from page 2.

– You specify pages 2–n. Because n represents the last page, the document property data
is extracted from the last page if the document has two or more pages.

♦ If you specify only page n, RICOH ProcessDirector Plug-in for Adobe Acrobat does
not extract the document property data from any page in a document.

7. Use the Document Properties section of the definition window to select a document property and
define the property extraction rule. This section contains the full text of the first line of the text data
you selected. If you choose to edit an existing text block, this section contains all of the document
properties you have defined for the text block. Follow these steps to define a new document
property and the modifier extraction rule for it.
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1. Click the add icon ( ) to add a new document property definition row.

2. Select a RICOH ProcessDirector document property from the Property list. You can define
your own document property by typing in a document property name; however, you cannot
use that document property in RICOH ProcessDirector. You should only define your own
document properties when you are only using RICOH ProcessDirector Plug-in for Adobe
Acrobat to export document property values to a text file.

3. Select the Line of the text block from which you want to extract the selected document
property. You can select the line using a top-down or a bottom-up reference. To select a line
using a top-down reference, select 1 through n (where n is a positive whole number). To
select a bottom-up reference, select Last or select Last - x (where x is the number of rows up
from the last row). Instead of selecting the row value from the list, you can enter the row
number directly into the Line field.

4. Select the edit icon ( ) to display aModify Text window where you define one or more
modifier extraction rules to extract the exact document property you need.

5. Choose one of the following modifiers:

CCoonntteenntt mmooddiiffiieerrss

Modifier Action

Remove Character Type one character or a blank character (use the space bar to
type a blank character) that you want to remove from the
value. The character is case-sensitive. Then select one of these
buttons:
• Remove all instances of the character

The specified character is removed from all positions in the
value.

For example, an account number is: 324-1443255-11.
You can type a - to remove all - characters from the value,
producing 324144325511.

• Remove leading characters
The specified character is removed from the beginning of
the value. For example, if you type a blank character, all
blank characters are removed from the beginning of the
value.

• Remove trailing characters
The specified character is removed from the end of the
value. For example, if you type a blank character, all
blank characters are removed from the end of the value.

• Remove leading and trailing characters
The specified character is removed from the beginning and
end of the value. For example, if you type a blank
character, all blank characters are removed from the
beginning and end of the value.

Substring by Position Select Beginning of Line or End of Line from the Starting
From list. Select a number for First Position to indicate the
location of the first character in the text value. Select a number
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Modifier Action

for Number to Retain to indicate how many characters are
retained.

Substring by Delimiter Type a character or a blank character in the Delimiter field to
indicate where the text value is split into separate string
segments. The character and the text string are case-sensitive.

Select Beginning of Line or End of Line from the Starting
From drop-down menu.

Select a number for First Position to define the position of the
delimiter in the text string.

Select a number for Number to Retain to define the number
of text string segments to retain.

These examples show how to select text string segments by
specifying a delimiter:
• For the account number 324-1443255-11, you can use -

as the delimiter to split the value into these three text strings:
324, 1443255, and 11. Select Beginning of Line. To
select the second and third text strings (1443255 and 11),
select 2 for both First Position and Number to Retain.

• For the mailing address Eldorado Springs CO 80025, you
can use a blank character as the delimiter to split the value
into these four text strings: Eldorado, Springs, CO, and
80025. Select End of Line.

– To select the zip code, select 1 for both First Position
and Number to Retain.

– To select the state, select 2 for First Position and 1 for
Number to Retain.

– To select the city, select 3 for First Position and 10 for
Number to Retain. By specifying 10 for Number to
Retain, you can select city names with up to ten words.

Pad with Character Select Beginning of Line or End of Line from the Padding
Location list. Enter a character or a blank character as the
padding character into the Character to Pad with field.

Enter a number in theMinimum Padded Text Length field to
define the minimum length of the text string. If the number of
characters in the text string is less than this minimum length,
padding characters are added until the text string equals the
minimum length.

When you use a modifier to define a text extraction rule, the Text to Modify field at the top
of the Modify Text window contains the selected line plus any edits you make to the line. The
Modified Value field to the right of a modifier displays the text that results when that modifier
is applied to the text it received from either the modifier above it or the Text to Modify field
(if you are defining the first modifier).
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6. Continue to apply modifiers until you extract the value you want from the selected line. Click

the icon to add a new modifier. The Final Text field below the list of modifiers displays
the final modified value, after all modifier extraction rules are applied.

For the selected modifier, theModifier Initial Text field at the bottom of the window displays
the value before the modifier is applied. TheModified Text field displays the value after the
modifier is applied.

7. Use the modifier management icons near the top of the window to delete and reorder the

modifier extraction rules. Use the icon to delete the selected modifier extraction rules. Use
the up and down arrow icons to reorder the rules. The rules are applied to the line in order
from top to bottom.

8. Click the OK button to save the line extraction rule.

8. Continue to define the other document properties you need to extract from a line in the block. You
can select the same line that you used in another document property. If you need to delete a
document property or want to rearrange their order, place a check mark in the box in front of a

document property, and use the icon and the up down arrow icons.

9. When you have finished defining document properties, click OK.

10. Click Ricoh→ View Document Property Values to verify that the properties have the content
you want.

11. OOppttiioonnaall:: You can edit the text block definition by double-clicking its box or by right-clicking the
box and selecting Edit.

12. When you are ready to save all your enhancements to the PDF file, including the new document
properties definition, click Ricoh→ Save Control File.

13. Move the control file to a directory location used by a RICOH ProcessDirector server and include
its name and location in a RICOH ProcessDirector IdentifyPDFDocuments step. This control file
must also contain the page group definition that defines the documents in the PDF files processed
by that step.

Defining an address block

You can define document properties in an address block in each document in a PDF file. After you
define the document properties, you can extract and view them or save them in a text file.

Use the Define Multiple Properties function to define document properties for addresses if:

• The address components are not in block form.

• You want to give the document properties your own names.

• The Define Address Block function assigns one or more components of the address text to the
wrong document property.

To define an address block:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group definition or define a page group.
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Tip: Before you select an address block, scan your sample PDF file for the most complicated and
longest example of addresses in the PDF files that you are going to process. For example, if the
first document in your PDF file contains an address of only three rows, and page 80 contains a
five-row address, draw the box around the five-row address so you can work with the most
complicated address. When you view document property values, you can verify that each
document property in shorter address blocks has the proper value.

2. Left-click just above the top left corner of an address area and drag the mouse to capture all rows
of the address.

3. Select Define Address Block from the popup menu.

4. Examine the Selected Address section of the Define Address Block window. If you have not
captured all the lines in the address block, click Cancel and draw the box around the address
again. Repeat this step until the address you want is displayed in the rows of the Selected
Address table.

5. Type a Name for the address block.

6. Use the Extraction Conditions section to specify the page in each document from which address
block data will be extracted. Do either of these:

• Select Pages based on a rule, and then select a rule from the drop-down list. The default
rule is First Front Only. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

The Last Back, Last Front, and Last Page rules do not work with address block extraction.

• Select Specific pages and type the page in each document that you want.
If you specify multiple pages, RICOH ProcessDirector Plug-in for Adobe Acrobat extracts the
address block from the last specified page in each document. Examples:

– You specify pages 2–4. If a document has four or more pages, the address block is
extracted from page 4. If a document has three pages, the address block is extracted
from page 3. If a document has two pages, the address block is extracted from page 2.

– You specify pages 2,4. If a document has four or more pages, the address block is
extracted from page 4. If a document has 2–3 pages, the address block is extracted from
page 2.

– You specify pages 2–n. Because n represents the last page, the address block is
extracted from the last page if the document has two or more pages.

If you specify only page n, RICOH ProcessDirector Plug-in for Adobe Acrobat does not
extract the address block from any page in a document.

7. Select an address type:

• Address lines 1–7
This option defines seven document properties (Doc.Address.1 through Doc.Address.7)
based on the first seven lines in the address block. Subsequent lines are ignored.
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• U.S. addresses
This option defines eight document properties:

– Doc.Address.FullName

– Doc.Address.Primary

– Doc.Address.Secondary

– Doc.Address.Other

– Doc.Address.City

– Doc.Address.State

– Doc.Address.ZipCode

– Doc.Address.CityStateZip

Each component of address text in the Selected Address becomes a value for a document
property in the Address Document Properties area.

8. Check to make sure that each document property has the proper value.

9. Click OK to create the document properties for the address block.

10. Click Ricoh→ View Document Property Values to verify the properties have the content you
want.

11. Optional: You can edit the address block definition by double-clicking its box or by right-clicking
the box and selecting Edit.

12. When you are ready to save all your enhancements to the PDF file, including the new document
properties for the address block, click Ricoh→ Save Control File.

13. Make the control file accessible by your RICOH ProcessDirector server and include its name and
location in an IdentifyPDFDocuments step. This control file must also contain the page group
definition that defines the documents in the PDF files processed by that step.

Viewing document property values

After you create a document property in a sample PDF file, you can view the data values for that
property. You view document property values to verify that you have selected the right location for the
property and defined the correct conditional extraction rules. You can click a document property value
to go to the first page of the page group that contains the value.

Follow these steps to view a table of extracted document property values.

1. Open a PDF file in Adobe Acrobat Professional and load the control file that has the document
properties you want to view.

2. Click Ricoh→ View Document Property Values.
In the Document Property View window, you see document property values for the number of
pages that you defined in the Pages to Process preferences setting.

3. To view fewer or more document property values, change the Number of pages to process
and click Update table.
The more pages you specify, the longer RICOH ProcessDirector Plug-in for Adobe Acrobat takes
to view document property values.
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4. Optional: Click any row in the document property table to go to the first page in the page group
that contains the document property value.

Tip: Keep this window open as you define document properties, so you can update the values in
the table to verify you have correctly selected the property.

Saving document property values

After you create document properties in a sample PDF file, you can save the data values for those
properties. For example, you can save the account numbers in a PDF file that you plan on printing for
an audit or printed in the past for an audit.

To save document property values:

1. While viewing document property values, click Save.

2. Select a location for the file and type a name, or use the name and location of the PDF file with a
.txt extension.

3. Click Save.
RICOH ProcessDirector Plug-in for Adobe Acrobat generates a tab-delimited text file containing
the values.

WWoorrkkiinngg wwiitthh rruulleess
A rule is a set of one or more conditions. You can apply the conditions specified by a rule to place
markup, extract data, or specify media and finishing options. You can also include a rule as a condition
within another rule.

For example, you can use a rule to:

• Place a barcode on the first page of each document in your PDF file

• Extract a customer’s name when the city in the mailing address is New York

• Specify gold media for the first page of each document for a Gold Club member

Each condition in a rule compares two values. The first value can be a Predefined Rule (a rule defined
by RICOH ProcessDirector Plug-in for Adobe Acrobat that specifies pages within documents), a
Custom Rule (a rule that you have defined), a conditional trigger, a job property, a document
property, or a statistic. The choices for the second value depend on the first value.

When you create a rule with multiple conditions, you can specify whether the rule requires all conditions
to be met or any condition to be met.

Rules can evaluate static and dynamic values. For example, a rule can evaluate whether the total
number of documents in a job is greater than 10. A rule can also evaluate whether the value of the
Doc.Begin.Balance document property is equal to the value of the Doc.End.Balance document
property.

The Figure below shows a rule with five different types of conditions.
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Rule with multiple conditions

Pre-defined rules

RICOH ProcessDirector Plug-in for Adobe Acrobat has 11 pre-defined rules that apply markup to, set
media and finishing options for, or extract data from specific pages within each document in a PDF file.
For example, you can use a pre-defined rule to place an image on all front pages in each document.

The table below describes each pre-defined rule.

PPrree--ddeeffiinneedd rruulleess

Rule Definition
All Front Pages All front-facing pages in each page group. If the rule is used to define a

document property, the value extracted is from the last front page in a page
group.

All Back Pages All back-facing pages in each page group. This rule does not apply to a
simplex job. If the rule is used to define a document property in a duplex job,
the value extracted is from the last back page in a page group.

All Pages Markup prints on all pages in each page group. Document properties values
are extracted from the last page (either front or back) in a page group. If a rule
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Rule Definition

does not have a condition with a pre-defined rule, RICOH ProcessDirector
Plug-in for Adobe Acrobat applies the rule to All Pages.

First Front Only First page in each page group.

First Back Only First back page in each page group. This rule does not apply to simplex jobs.

Second Front Only Second front-facing page in each page group.

Second Back Only Second back-facing page in each page group. This rule does not apply to
simplex jobs or to jobs that do not have a second back page.

Last Front Only Last front-facing page in each page group.

Last Back Only Last back of each page group. This rule does not apply to simplex jobs.

Last Page Only Last page of each page group (front or back is not a factor).

No Pages No pages. To keep a rule from being applied, you can add a condition with
No Pages = True.

Conditional triggers

A conditional trigger is text that determines whether a condition is met.

If you want to place a barcode on a page whenever the word Invoice appears at the top of the page,
you can define a conditional trigger for the word Invoice, define a rule with the trigger as a condition,
and use the rule to apply the barcode.

If you want to use special media when the word Overdue appears at the bottom of the page, you can
define a conditional trigger for the word Overdue, define a rule with the trigger as a condition, and
use the rule to set the media.

If you want to extract the value of a document property whenever the words Account Summary
appear on the right side of the page, you can define a conditional trigger for the words Account
Summary, define a rule with the trigger as a condition, and use the rule when you define the document
property.

Tip: If you know that the word you want to define as a conditional trigger occurs on a specific page in
every page group, you can use the Stat.CurrentPageInDocument statistic instead of a conditional
trigger.

Using job properties or document properties in rules

You can compare a job property or document property to a static value, such as a number or word, or
to a dynamic value, such as job property, document property or statistic.

For example, you have two inserters, and you want to choose the inserter for different jobs. You can use
the SetDocPropsFromConditions step in your workflow to set a value of a specific job property such as
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Doc.Insert.InserterID. In RICOH ProcessDirector Plug-in for Adobe Acrobat, you can use the Doc.
Insert.InserterID job property in a rule. RICOH ProcessDirector can apply a specific barcode or image
based on the control file (which contains the rules you defined in RICOH ProcessDirector Plug-in for
Adobe Acrobat) that you add to a BuildPDFFromDocuments step.

When using a document or job property value in a rule, define your value so it matches the value of the
property when RICOH ProcessDirector processes the page groups in the PDF file. For example, the
values of the Doc.Insert.InserterID job property in RICOH ProcessDirector are 01 and 02. Use those
values when you define a rule with the Doc.Insert.InserterID job property as a condition. Do not use
One and Two.

Using statistics in rules

You can compare a statistic to a static value, such as a number or word, or to a dynamic value, such as
a job property, document property, or statistic.

For example, you want to create a barcode on the third page of every document. You select the Stat.
CurrentPageInDocument statistic, select = as the mathematical symbol, and type 3 in the Text field.
The fifth condition in the Figure Rule with multiple conditions, p. 40 specifies a statistic.

The table below describes the available statistics.

SSttaattiissttiiccss ooppttiioonnss ffoorr rruulleess

Keyword Level Definition
Stat.TotalDocumentsInJob Print job The total number of documents in the current

print job.

Stat.TotalSheetsInJob Print job The total number of sheets in the current print
job.

Stat.TotalPagesInDocument Document The total count of pages in the current document.

Stat.TotalSheetsInDocument Document The total count of sheets in the current document.

Stat.CurrentDocumentInJob Document The number of the current document in its print
job, starting at 1. For example, the value of Stat.
CurrentDocumentInJob for the third document is
3.

Stat.CurrentPageInDocument Page The number of the current page in its document,
starting at 1. For example, the value of Stat.
CurrentPageInDocument for the second page in
a document is 2.

Stat.CurrentSheetInDocument Page The number of the current sheet in its document,
starting at 1.

Stat.CurrentPageInJob Page The number of the current page in its print file,
starting at 1 and always from the Start page of
the job. For example, the value of Stat.
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Keyword Level Definition

CurrentPageInJob for the tenth page in the print
file is 10.

Stat.CurrentSheetInJob Page The number of the current sheet in its print file,
starting at 1 and always from the Start page of
the job.

Stat.CurrentMedia Page The media specified for the current page in a
print job when the IdentifyPDFDocuments step
was run. If no media is specified for the page,
Stat.CurrentMedia provides the media specified
for the job. If no media is specified for the page
or the job, Stat.CurrentMedia does not provide
a value. For example, the value of Stat.
CurrentMedia for the first page of a document is
Letterhead.

• Stat_CurrentMedia does not provide media
specified using RICOH ProcessDirector Plug-
in for Adobe Acrobat.

• You cannot preview markup that is placed
using a RICOH ProcessDirector Plug-in for
Adobe Acrobat rule that evaluates Stat.
CurrentMedia.

Although some statistics describe job-level values, RICOH ProcessDirector evaluates each page in a
document when determining whether or not to apply markup or extract the value of a document
property.

Defining a rule

You can define rules that specify conditions for markup. You can also define rules to set media and
finishing options, or to extract data.

Before you define a rule, make sure you have defined each custom rule, document property, and
conditional trigger that you want to use as conditions in the rule.

To define a rule:

1. Click Ricoh→Manage Rules.

2. Click the icon.

Rules are shown alphabetically by name.

Tip: In a markup dialog, you can define a rule by clicking the icon and edit a rule by clicking
the icon.
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3. Type a Name for the rule. You can use alphanumeric characters, periods, underscores, spaces,
and special characters (such as @, #, $, or %).

4. Optional: Type a Description.

5. Specify whether RICOH ProcessDirector Plug-in for Adobe Acrobat should apply the rule when
any or all of its conditions are met.

6. Specify the first condition.

1. Click the down arrow for the Not set drop-down list.

2. Click the + icon next to Predefined Rule, Custom Rule, Trigger, Job Property, Document
Property, or Statistic and select the item you want for the first part of the condition.

If a choice (such as custom rules, conditional triggers, or document properties) does not have
any items, the choice is grayed out.

To display all items with a word in their names, type the word and press the down arrow key
on your keyboard. You can also type the word and click the down arrow for the drop-down
list.

3. Select a mathematical symbol, such as = (equals) or ≠ (does not equal), to compare the two
parts of the condition.

4. Specify the second part of the condition:

• For a rule, select True or False.

• For a conditional trigger, verify that the condition has the value you want. If not, select a
new conditional trigger.

• For a job property, document property, or statistic, type a value. You can also select any
job property, document property, or statistic.

7. For a rule with multiple conditions, click the icon and specify the next condition.

Repeat this step until you have defined all the conditions in the rule.

8. Click OK to create the rule and add it to the Rules Manager.

Examples

Rule with one condition: a pre-defined rule
To place markup on the first front page of each document, define a rule with a pre-defined rule as
its only condition: First Front Only = True

Three rules that each have one condition: a document property
A job contains sales statements for members at three different levels based on sales performance:
Bronze, Silver, and Gold. You want to identify each membership level.

• In RICOH ProcessDirector, define a document property: doc.member.level.

• In RICOH ProcessDirector Plug-in for Adobe Acrobat, define three rules:

– Gold Level
doc.member.level = GOLD

– Silver Level
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doc.member.level = SILVER

– Bronze Level
doc.member.level = BRONZE

Rule with multiple conditions
A job contains sales statements for members at three different levels based on sales performance:
Bronze, Silver, and Gold. You want to print a reward coupon on the first page of each statement for
Gold and Silver members. This example uses three rules defined in the previous examples:

• First Front Only

• Gold Level

• Silver Level

First, define a Top Sales rule with two conditions, which you apply when any condition is met:

• Gold Level = True

• Silver Level = True

Next, define a Top Sales — First Front rule with two conditions, which you apply when all
conditions are met.

• First Front Only = True

• Top Sales = True

Finally, select the Add Image option. Apply settings by clicking Pages/documents based on
conditions and selecting the Top Sales — First Front rule. Specify the path to the image.

Rule with one condition: a job property
To print VOID: DO NOT MAIL on each page of a test job:

• Define a Test Job rule with a job property as its only condition: Job.TestJob = Yes

• Select the Add Text option. Apply settings by clicking Pages/documents based on
conditions and selecting the Test Job rule. Select Text as the Content Type and type VOID:
DO NOT MAIL for the value.

Rule with a condition that uses dynamic data
When a statement has different addresses for billing and shipping, you want to print Order sent to
shipping address on the statement:

• Define two document properties: doc.shipping.address and doc.billing.address.

• Define a Sent to Shipping Address rule with this condition: doc.shipping.address ≠ doc.
billing.address

• Select the Add Text option. Apply settings by clicking Pages/documents based on
conditions and selecting the Sent to Shipping Address rule. Select Text as the Content Type
and type Order shipped to shipping address for the value.
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Defining a conditional trigger

You can define text in a PDF file as a trigger to control whether markup is applied to a page when
RICOH ProcessDirector processes a PDF file. The text can also control whether media and finishing
options are applied to a page and whether document properties are extracted from a page.

If you are experimenting to determine which text to use as a conditional trigger, you do not have to
save the conditional trigger in a control file before you use preview mode. For preview mode, RICOH
ProcessDirector Plug-in for Adobe Acrobat generates a temporary control file.

To define a conditional trigger:

1. Open a PDF file in Adobe Acrobat Professional and load a control file that contains the page
group definition.

2. Left-click slightly above and to the left of the text that you want to use as a conditional trigger.
Drag the mouse to draw a box around the text.

• If you draw a box around an area with no text, the conditional trigger determines that its
condition is met whenever the area has no text. The condition is also met when the area has
an image or other markup but no text.

3. Select Define Conditional Trigger.

4. Verify that the Trigger box has the text that you selected. If not, click Cancel and select the text
again.

5. Type a Name for the trigger. Do not use spaces or special characters (such as @, #, $, or %) in
the name. You can use periods and underscores.

6. Click OK to create the trigger.

The conditional trigger is now available on the drop-down list for specifying conditions when
defining rules.

Example

You want to extract a customer account number for every page group. Each invoice in your PDF file
contains the word Account near the upper left of the first or second page of every document. Each
customer account number is printed to the right of that word. The longer invoices also have the customer
account number on the third page.You draw a box around the first occurrence of the word Account in
the PDF file you are enhancing, and you name the trigger acct_trg.

Next, you create a rule with a condition that specifies the trigger: acct_trg = Account.

Finally, you define a document property that applies the rule.
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Managing rules

The Rules Manager dialog shows information about your rules. You can define new rules, and edit or
delete existing rules.

For each rule, the dialog shows the rule name and description. Rules appear on the list in alphabetical
order by name.

To define a new rule, click the icon.

To work with a rule, select it. Click the icon to modify the rule or the icon to delete it.

AAddddiinngg mmaarrkkuupp ttoo aa PPDDFF ffiillee
You use RICOH ProcessDirector Plug-in for Adobe Acrobat to add markup to a PDF file that represents
your production PDF files. You mark up a PDF file by drawing a box around existing content or by
drawing a box to add new markup. You can preview the PDF file as you add markup to verify its
content and placement on specific pages. When you are done enhancing the sample PDF file, you save
your changes to one or more control files and make them accessible by a RICOH ProcessDirector
server so it can apply the control files to production PDF files.

Before you add markup to a PDF file, you must define the page grouping for the documents in the PDF
file. See Defining a page group, p. 23 for more information. When previewing the page placement of
markup, you may not be able to view the placement or content that RICOH ProcessDirector applies to
markup when processing your RICOH ProcessDirector workflows. RICOH ProcessDirector Plug-in for
Adobe Acrobat may not have access to all of the properties that you use to define both page placement
rules and markup content (such as in text and barcodes). See Previewing markup, p. 20 for more
information.

When RICOH ProcessDirector applies markup defined in the control files that you specified in a
BuildPDFFromDocuments step, RICOH ProcessDirector applies the markup in this order:

• Hidden areas

• Images

• Text

• OMR marks

• Barcodes

Adding a barcode to a PDF file

To add a barcode to a PDF file, select the area where you want to place the barcode, specify a
barcode type, and add content. You can limit the placement of a barcode to specific pages in each
page group by specifying a rule or typing page numbers.

RICOH ProcessDirector Plug-in for Adobe Acrobat supports the following barcode types:

• 2of5 (Interleaved 2 of 5)
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• Code128

• Code39

• Datamatrix

• IMB (Intelligent Mail Barcode)

• QR code (Quick Response Code)

• RM4SCC (Royal Mail 4-State Customer Code)

• RMM (Royal Mail Mailmark)

• If you are creating child jobs, make sure that the barcode type supports periods. Child jobs have a
period in the job number (for example, 10000001.1). Automated Verification workflows create
child jobs for open-loop reprints. The Postal Enablement GroupDocsForPostalProcess workflow
creates a child job when the documents in the job qualify for more postal processing.

You can create a barcode from content within the PDF file. For example, if your processing extracts the
customer account number for every mailpiece you print, you can create a barcode from the account
number. You first create a document property for the account number. You can then select that
document property when defining the barcode content.

If you want to use text in the PDF file to trigger placement of a barcode on a specific page in a page
group, you first create a conditional trigger on that text and define a rule with the trigger as a condition.
You can then select that rule when defining the barcode.

To add a barcode:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group definition or define a page group.

2. Use the left mouse button to draw a box where you want the barcode to print. You do not need
to draw the box to the exact size of the barcode.

The barcode is not resized to fit within the box. If you draw a box to the approximate size of the
barcode, you can see its position relative to all the markup you add to the PDF file.

3. Click Add Barcode.

4. Type a Name for the barcode. Do not use spaces or special characters (such as @, #, $, or %)
in the name. You can use periods and underscores.

5. OOppttiioonnaall:: Use the Location section of the definition window to change the placement of the
barcode by entering new Horizontal and Vertical coordinates. These coordinates specify the
distance between the top left corner of the page and the top left corner of the barcode, before
any rotation. If your manufacturing equipment has a specification for the location of the barcode,
use these coordinates to set a precise location.

• Width and Height change the size of the markup box but do not affect the location or size of
the barcode.

6. Select the clockwise Rotation (degrees). The reference point for rotating a barcode is its top left
corner.
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7. Use the Placement Conditions section to specify the pages to place the barcode on. Do either of
these steps:

• Select Pages based on a rule, and then select a rule from the list. The default rule is All
Pages. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

• Select Specify pages and type the pages in each page group that you want. You can:

– Use a hyphen to separate the first and last pages in a page range.

– Use a comma to separate page selections.

– Type n to specify the last page.
Example: a PDF file has two page groups. The first has four pages, and the second has
seven pages. Specifying pages 3–n places markup on pages 3–4 in the first page group,
and pages 3–7 in the second.
.

8. Use the Barcode Configuration section to define the mechanical attributes and type of the
barcode.

1. Use the Barcode Type list to select one of the following barcodes: 2of5, Code128,
Code39, Datamatrix, IMB, QR code, RM4SCC, or RMM.

2. OOppttiioonnaall:: Click the Settings button to set the mechanical attributes of the barcode.

The Table Barcode mechanical attributes, p. 49 describes the settings for each barcode type.

BBaarrccooddee mmeecchhaanniiccaall aattttrriibbuutteess

Barcode
type Attribute and description

2of5 and
Code39

The unit of measure for the numeric attributes for these barcode types is
millimeters.

barHeight This attribute determines the vertical height of each bar.

checksumMode This attribute determines the behavior of checksums.
• To add the checksum to the message, enter: add
• To check the checksum when rendering the barcode, enter: check
• To disable checksum processing, enter: ignore
• To enable the default barcode behavior, enter: auto

moduleWidth This attribute is the width of the narrow element.

widthFactor This attribute is the multiplier for the wide element or how
many times wider it is than the narrow element.

Code128 The unit of measure for the numeric attributes for this barcode type is
millimeters.

barHeight This attribute determines the vertical height of each bar.

checksumMode This attribute determines the behavior of checksums.
• To add the checksum to the message, enter: add
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Barcode
type Attribute and description

• To check the checksum when rendering the barcode, enter: check
• To disable checksum processing, enter: ignore
• To enable the default barcode behavior, enter: auto

moduleWidth This attribute is the width of the narrow element.

Datamatrix The unit of measure for the numeric attributes of this barcode type is
millimeters.

maxSize This attribute determines the maximum number of modules in
both X and Y directions.

minSize This attribute determines the minimum number of modules in both
X and Y directions.

moduleWidth This attribute determines the size of each pixel element.

shape The FORCE_SQUARE value forces the use of square symbols. No
other values are supported.

IMB and
RM4SCC

The unit of measure for the numeric attributes for these barcode types is
millimeters.

ascenderHeight This attribute defines the height of both the ascender and
descender sections of long bars.

intercharGapWidth This attribute defines the width of each gap. The
value you enter must be from 0.38 through 0.63 and must be the same as
the moduleWidth value.

moduleWidth This attribute defines the width of each bar and must be
from 0.38 through 0.63.

trackHeight This attribute defines the height each short track or center bar
and must be a value from 1.02 through 1.52.

QR code The unit of measure for the numeric attribute of this barcode type
(moduleWidth) is inches.

encoding This attribute defines the encoding type of the QR barcode.
To specify UTF-8 encoding, enter: Auto
To specify that the Unicode data is output in that format, enter: Shift_
JIS or another supported type of Shift JIS code points, such as sjis or
x-sjis.

• The input data for the barcode must always be Unicode character
points. Do not use Shift_JIS or any other non-Unicode input data.

errorcorrection This attribute defines the capability to restore the data in a
damaged QR barcode.

To specify that 7% of the code can be restored, enter: L
To specify that 15% of the code can be restored, enter:M
To specify that 25% of the code can be restored, enter: Q
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To specify that 30% of the code can be restored, enter: H

moduleWidth This attribute determines the size of each pixel element.

version Do not change this attribute; it is reserved for future use.

RMM shape This attribute determines the type of barcode.
• To specify a 2D Type 9 barcode, enter: square
• To specify a 2D Type 29 barcode, enter: rectangle

The values for the attribute are not case-sensitive.

9. Select one of the following from the Content Type list.

• Because RICOH ProcessDirector generates barcode content as it prepares a PDF file for
printing, RICOH ProcessDirector Plug-in for Adobe Acrobat cannot always determine valid
content for a barcode. For example, some barcodes cannot accept text or line breaks. If you
include invalid barcode content, the PDF file job might fail in the RICOH ProcessDirector
BuildPDFFromDocuments step.

Job Property Select a job property whose value you want to
include in the barcode.

Document Property Select a document property whose value you
want to include in the barcode.

Statistic Select a statistic whose value you want to include
in the barcode.

Text Enter text that you want to include in the barcode.

Line Break Select this content type when you want to force a
line break. The break occurs after the last
character of the prior barcode content.

Script Only select this option on the advice of your
software support representative.

1. OOppttiioonnaall:: If you selected a document property, job property, or statistic Content Type, you
can apply text modifier rules to the value of the property or statistic. Click the icon to
display a Modify Text window for defining one or more modifier extraction rules to extract
the exact value you need.

2. Enter text into the Text to Modify field. RICOH ProcessDirector generates or extracts statistics
and properties as it processes each page group in production PDF files. Because these values
are not available to RICOH ProcessDirector Plug-in for Adobe Acrobat, you must enter a text
value that represents the values that RICOH ProcessDirector processes. The modifier rule is a
template that is applied to all values of the content type that you selected. For example, you
want to print only the last eight digits of customer account number, and you have stored the
entire number into a document property. You select Document Property as the Content
Type, and select the account document property as the Content Value. You define two
Remove Character text modifier rules to strip dashes and spaces from the number to make
them all uniform. Then you define a Substring by Position rule to retain only the last eight
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digits. You do not need to know any single value of a document property to create modifier
rules. You need to know only the possible formats that could occur in your PDF files.

3. Choose one of these modifiers:

CCoonntteenntt mmooddiiffiieerrss

Modifier Action

Remove Character Type one character or a blank character (use the space bar to
type a blank character) that you want to remove from the
value. The character is case-sensitive. Then select one of these
buttons:
• Remove all instances of the character

The specified character is removed from all positions in the
value.

For example, an account number is: 324-1443255-11.
You can type a - to remove all - characters from the value,
producing 324144325511.

• Remove leading characters
The specified character is removed from the beginning of
the value. For example, if you type a blank character, all
blank characters are removed from the beginning of the
value.

• Remove trailing characters
The specified character is removed from the end of the
value. For example, if you type a blank character, all
blank characters are removed from the end of the value.

• Remove leading and trailing characters
The specified character is removed from the beginning and
end of the value. For example, if you type a blank
character, all blank characters are removed from the
beginning and end of the value.

Substring by Position Select Beginning of Line or End of Line from the Starting
From list. Select a number for First Position to indicate the
location of the first character in the text value. Select a number
for Number to Retain to indicate how many characters are
retained.
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Modifier Action

Substring by Delimiter Type a character or a blank character in the Delimiter field to
indicate where the text value is split into separate string
segments. The character and the text string are case-sensitive.

Select Beginning of Line or End of Line from the Starting
From drop-down menu.

Select a number for First Position to define the position of the
delimiter in the text string.

Select a number for Number to Retain to define the number
of text string segments to retain.

These examples show how to select text string segments by
specifying a delimiter:
• For the account number 324-1443255-11, you can use -

as the delimiter to split the value into these three text strings:
324, 1443255, and 11. Select Beginning of Line. To
select the second and third text strings (1443255 and 11),
select 2 for both First Position and Number to Retain.

• For the mailing address Eldorado Springs CO 80025, you
can use a blank character as the delimiter to split the value
into these four text strings: Eldorado, Springs, CO, and
80025. Select End of Line.

– To select the zip code, select 1 for both First Position
and Number to Retain.

– To select the state, select 2 for First Position and 1 for
Number to Retain.

– To select the city, select 3 for First Position and 10 for
Number to Retain. By specifying 10 for Number to
Retain, you can select city names with up to ten words.

Pad with Character Select Beginning of Line or End of Line from the Padding
Location list. Enter a character or a blank character as the
padding character into the Character to Pad with field.

Enter a number in theMinimum Padded Text Length field to
define the minimum length of the text string. If the number of
characters in the text string is less than this minimum length,
padding characters are added until the text string equals the
minimum length.

10. To add a new content definition row, click the icon. After you have added all content types
and modifier rules to the barcode, you can place a check mark in the box next to a content type

and use the up and down arrows to reorder the content. Use the icon to delete selected
content.

11. If you defined multiple lines of text and you want RICOH ProcessDirector Plug-in for Adobe
Acrobat to remove lines that only contain white space, click the Remove blank lines check box
to select it.
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12. To create your barcode configuration, click OK.

13. To verify that the barcode has the content and page placement you intended, click
Ricoh→ Preview.

14. OOppttiioonnaall:: You can edit the barcode definition by double-clicking the barcode box or by right-
clicking the box and clicking Edit.

15. When you are ready to save all your enhancements to the PDF file, including the new barcode
definition, click Ricoh→ Save Control File.

16. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of
the control file that contains the barcode definition.

Adding OMR marks to a PDF file

You can add a variety of OMR marks of different height, width, and pitch to a PDF file. You can limit the
placement of OMR marks to specific pages in each page group by specifying a rule or typing page
numbers.

• If your brand of inserters or other machinery requires specific OMR marks, you must use the
specifications from your supplier.

To add OMR marks:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group definition or define a page group.

2. Use the left mouse button to draw a box where you want the OMR marks to print. You do not
need to draw the box to the exact size of the OMR marks.

The OMR marks are not resized to fit within the box. If you draw a box to the approximate size of
the OMR marks, you can see their position relative to all the markup you add to the PDF file.

3. Select Add OMR.

4. Type a Name for the OMR marks. Do not use spaces or special characters (such as @, #, $, or
%). You can use periods and underscores.

5. Optional: Use the Location section of the definition window to change the placement of the OMR
marks by entering new Horizontal and Vertical coordinates. These coordinates specify the
distance between the top left corner of the page and the top left corner of the OMR marks. If your
manufacturing equipment has a specification for the location of the OMR marks, use these
coordinates to set a precise location.

Width and Height change the size of the markup box but do not affect the location or size of the
OMR mark.

6. Use the Placement Conditions section to specify the pages to place the OMR marks on. Do either
of these:

• Select Pages based on a rule, and then select a rule from the drop-down list. The default
rule is All Pages. You can also:
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– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

• Select Specify pages and type the pages in each page group that you want. You can:

– Use a hyphen to separate the first and last pages in a page range.

– Use a comma to separate page selections.

– Type n to specify the last page.
Example: a PDF file has two page groups. The first has four pages, and the second has
seven pages. Specifying pages 3–n places markup on pages 3–4 in the first page group,
and pages 3–7 in the second.
.

7. Use the Physical Configuration section to define the OMR content and form. If the OMR Content
drop-down list has the name of the configuration you need, select it from the list. OMR
configuration files have a .omr extension and are saved by default in the RICOH ProcessDirector
Plug-in for Adobe Acrobat application data directory. If you need a different configuration than
the one that is selected, click theManage Content button.

Tip:

• You can view the application data directory location for the current user by typing %
appdata% in Windows Run command line and clicking OK.

1. If you do not want to modify the selected OMR configuration file, click New or Copy.

2. Use the Add and Remove buttons to manage the OMR content in the Chosen Marks box.
Use theMove Up,Move Down, and Reverse buttons to specify the order in which the
marks are printed.

The Table Available OMR marks, p. 55 describes the marks you can add to your OMR
definition.

AAvvaaiillaabbllee OOMMRR mmaarrkkss

OMR mark name Description

Blank Leaves a space equal to the OMR pitch value plus the OMR
height value.

Collate Indicates that the current group of pages need to be
enveloped. This mark normally appears only on the first or last
sheet of a page group.

Feeder Defines the location for a feeder station mark. There can be
multiple occurrences of this mark.

Gate Sometimes used to mark the start of an OMR set. If requested,
this mark is always present.

Parity Used to bring the total number of bars up to the required
parity, either even or odd.

Safety Sometimes used to mark the end of an OMR set. If requested,
this mark is always present.
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OMR mark name Description

Sequence Displays a sequence using from one to three bars or from one
to four bars.

Void Leaves a space equal to the OMR Pitch value.

3. In the OMR Configuration section of the Add OMR window, first select your Units of
measure. Enter numeric values into the Height and Length fields to define the height and
width of each OMR mark. Enter a numeric value into the Pitch field to define the distance
between each OMR mark.

4. In the Parity section, select whether your inserter uses Odd or Even parity checking.

5. Select First Page or Last Page collation.

6. If you select a sequence bar type, use the Sequence Range section to specify 1 through 7
for three bars or 1 through 15 for four bars.

7. If you select a sequence bar type, use the Sequence section to define the bit order of the
sequence bars. Select Up to print the bars in a 1, 2, 4 order (three bars) or in 1, 2, 4, 8
order (four bars). Select Down to print the bars in 4, 2, 1 order or in 8, 4, 2, 1 order.

If the sequence is Up, a bar in the first position represents 1, a bar in the second position
represents 2, bars in the first and second positions represent three, a bar in the fourth position
represents 4, bars in the first and fourth positions represent 5, and so on.

8. After you have defined the OMR content and structure definition click Save and then click
Cancel to return to the main OMR configuration window.

8. Use the Inserts field to select a fixed set of inserts for an entire job. You enter either a 0 or a 1 to
tell the inserter which inserts to pull for every document in a job. For example, on a six station
inserter with stations numbered from one to six, if you want to add the inserts from stations two
and four, you enter the value 010100 into the Inserts field.

9. Click Ricoh→ Preview to verify the OMR has the structure and page placement you intended.

10. Optional: You can edit the OMR definition by double clicking the OMR box or by right-clicking
the box and selecting Edit.

11. When you are ready to save all your enhancements to the PDF file, including the new OMR
marks definition, click Ricoh→ Save Control File.
Tip:

• When you save an OMR configuration, the OMR definition is saved to an OMR
configuration file in the InfoPrint directory in your application data directory. When you
mark up a PDF file, add OMR marks, and save a control file, the OMR configuration is also
saved into the control file. You specify that control file in a BuildPDFFromDocuments step. You
do not need to move the OMR configuration file to a directory accessible by RICOH
ProcessDirector, but you can move the OMR configuration file to another computer used by
RICOH ProcessDirector Plug-in for Adobe Acrobat if you want to share the configuration with
someone else.

12. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of the
control file that contains the OMR marks definition.
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Adding an image to a PDF file

You can add JPEG images, such as a logo or an advertisement, to the PDF file. You can limit the
placement of an image to specific pages in each page group by specifying a rule or typing page
numbers. RICOH ProcessDirector Plug-in for Adobe Acrobat can process only JPEG files that are in
RGB format; the CMYK format is not supported.

To add an image:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group or define a page group.

2. Use the left mouse button to draw a box where you want the image to print. You can also place
an image over a hidden area markup box.

The image is not resized to match the size of the box. If you draw a box to the approximate size
of the image, you can see its position relative to all the markup you add to the PDF file.

3. Click Add Image.

4. Use the Location section of the definition window to change the placement of the image by
entering new Horizontal and Vertical coordinates. These coordinates specify the distance
between the top left corner of the page and the top left corner of the image.

Width and Height change the size of the markup box but do not affect the location or size of the
image.

5. Type a Name for the image. Do not use spaces or special characters (such as @, #, $, or %).
You can use periods and underscores.

6. Use the Placement Conditions section to specify the pages to place the image on. Do either of
these:

• Select Pages based on a rule, and then select a rule from the drop-down list. The default
rule is All Pages. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

• Select Specify pages and type the pages in each page group that you want. You can:

– Use a hyphen to separate the first and last pages in a page range.

– Use a comma to separate page selections.

– Type n to specify the last page.
Example: a PDF file has two page groups. The first has four pages, and the second has
seven pages. Specifying pages 3–n places markup on pages 3–4 in the first page group,
and pages 3–7 in the second.
.
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7. If the image you are defining exists in a file path that you can access, select Browse, click the
JPEG image file you want to add to the PDF file, and click Open. When you save this image
definition to a control file, the image file is embedded in the control file. You do not need to copy
the image to a directory accessible to a RICOH ProcessDirector server.

Instead of embedding the image file in a control file, you can enter an image file name and
location that RICOH ProcessDirector can access when a BuildPDFFromDocuments step
processes PDF files. If you specify an image file name and location that RICOH ProcessDirector
Plug-in for Adobe Acrobat cannot find, a message informs you that the image was not found. If
you want to use the image file name and path for the RICOH ProcessDirector server, select Yes.
Otherwise, select No.

To specify a directory location accessible to RICOH ProcessDirector, type the full directory path
and file name (for example, /aiw/aiw1/images/myimage.jpg). If RICOH ProcessDirector
cannot find the image file when it processes a PDF file, the job fails in the
BuildPDFFromDocuments step.

8. Click OK to create the image configuration.

9. Optional: Click Ricoh→ Preview to verify that the image has the page placement you intended.

10. Optional: You can edit the image definition by double-clicking the image box or by right-clicking
the box and selecting Edit.

11. When you are ready to save all your enhancements to the PDF file, including the new image
definition, click Ricoh→ Save Control File.

12. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of the
control file that contains the image definition.

Hiding an area in a PDF file

You can hide an area of a PDF file by defining a cover block to keep an area on a page from being
shown or printed when you process a production PDF file in RICOH ProcessDirector. You can limit the
placement of a hidden area to specific pages in each page group by specifying a rule or typing page
numbers.

Typically you hide areas of a PDF file that contain images, text, barcodes, or other types of optical
marks that are no longer needed. For example, if you want to replace an existing optical mark with a
smaller Datamatrix barcode, you draw a box over the area that contains the old marks to hide them.
You then place a new Datamatrix barcode on top of the hidden area. When RICOH ProcessDirector
processes a PDF file with a hidden area, it blocks that area from having any ink applied, so the hidden
area is the same color as the print media. When RICOH ProcessDirector applies markup to a PDF file,
the BuildPDFFromDocuments step applies all hidden areas before applying other markup.

To hide an area:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group or define a page group.

2. Use the left mouse button to draw a box around the area of the PDF file that you want to hide.

3. Click Hide Area.

4. Optional: Use the Location section of the definition window to change the placement and size of
the hidden area. The Horizontal and Vertical coordinates specify the distance between the top
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left corner of the page and the top left corner of the hidden area. TheWidth and Height specify
the size of the hidden area.

5. Type a Name for the hidden area. Do not use spaces or special characters (such as @, #, $, or
%). You can use periods and underscores.

6. Use the Placement Conditions section to specify the pages to place the hidden area on. Do either
of these:

• Select Pages based on a rule, and then select a rule from the drop-down list. The default
rule is All Pages. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

• Select Specify pages and type the pages in each page group that you want. You can:

– Use a hyphen to separate the first and last pages in a page range.

– Use a comma to separate page selections.

– Type n to specify the last page.
Example: a PDF file has two page groups. The first has four pages, and the second has
seven pages. Specifying pages 3–n places markup on pages 3–4 in the first page group,
and pages 3–7 in the second.
.

7. Click OK to create the hidden area definition.

8. Click Ricoh→ Preview to verify the hidden area has the page placement you intended.

9. Optional: You can edit the hidden area definition by double-clicking the hidden area box or by
right-clicking the box and selecting Edit.

10. When you are ready to save all your enhancements to the PDF file, including the new hidden
area definition, click Ricoh→ Save Control File.

11. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of the
control file that contains the hidden area definition.

Adding text to a PDF file

You can add fixed text or variable text to a PDF file. You also can combine fixed and variable text in
one text box. Fixed text is text that you type. Variable text is data from document properties, job
properties, or statistics.

To add text:

1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains a page
group or define a page group.

2. Use the left mouse button to draw a box in the area where you want to add text.

RICOH ProcessDirector Plug-in for Adobe Acrobat uses the upper left corner of the text box to
position the text. All the text you specify is printed at the size you specify, even if the text does not
fit inside the box.
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3. Click Add Text.

4. Optional: Use the Location section of the definition window to change the placement of the text
by entering new Horizontal and Vertical coordinates. These coordinates specify the distance
between the top left corner of the page and the top left corner of the text box.

Width and Height change the size of the markup box but do not affect the location or size of the
text.

5. Type a Name for the text box. Do not use spaces or special characters (such as @, #, $, or %) in
the name. You can use periods and underscores.

6. Select a value from the Align with enclosed text drop-down list:

• If you want to align the text that you are adding with the first occurrence of existing text
enclosed by the box you drew, select First occurrence. RICOH ProcessDirector Plug-in for
Adobe Acrobat maintains that position each time that it adds the text.

• If you want to align the text that you are adding with each occurrence of existing text
enclosed by the box you drew, select Each occurrence.

• If you do not want the text aligned, use the default value Disabled.

Aligning new text with enclosed text is the most precise way to replace existing text.

• The Align with enclosed text function works best when the new text and the existing text are
in the same font. If the fonts are different, RICOH ProcessDirector Plug-in for Adobe Acrobat
aligns the baselines of the fonts.

• RICOH ProcessDirector Plug-in for Adobe Acrobat always aligns the first line of the new text
with the first line of the existing text.

• If the enclosed text is not left-justified, RICOH ProcessDirector Plug-in for Adobe Acrobat
aligns the new text with the left-most line of the existing text.

7. Select the clockwise Rotation (degrees). The reference point for rotating a text box is its top left
corner.

8. Use the Placement Conditions section to specify the pages to place the text on. Do either of these:

• Select Pages based on a rule, and then select a rule from the drop-down list. The default
rule is All Pages. You can also:

– Click the icon to define a new rule. See Defining a rule, p. 43 for more information.

– Click the icon to go to the Rules Manager.

• Select Specify pages and type the pages in each page group that you want. You can:

– Use a hyphen to separate the first and last pages in a page range.

– Use a comma to separate page selections.

– Type n to specify the last page.
Example: a PDF file has two page groups. The first has four pages, and the second has
seven pages. Specifying pages 3–n places markup on pages 3–4 in the first page group,
and pages 3–7 in the second.
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9. Use the Font section to select the font, size, and color.

The font drop-down list includes all fonts available to Adobe Acrobat except for fonts that do not
permit embedding in a PDF file.

• To make a font available to RICOH ProcessDirector Plug-in for Adobe Acrobat, install it in the
Windows Fonts folder.

• RICOH ProcessDirector Plug-in for Adobe Acrobat does not support alternate letter forms,
including ligatures, swashes, and letter forms that vary according to where they appear in a
word. Right-to-left languages, such as Hebrew and Arabic, are rendered incorrectly.
However, the font drop-down list shows all fonts installed in the Windows Fonts folder,
including fonts for right-to-left languages and fonts with unsupported alternate letter forms.

• When a font is added to a control file, it is the user’s responsibility to make sure that the font is
licensed on all machines that use the control file to process a PDF document.

10. Define the content of the text you are adding:

1. Select the first Content Type from the drop-down list. You can select as many of the following
types as you need to define the text content:

TTeexxtt mmaarrkkuupp ccoonntteenntt ttyyppeess

Content Type Description

Text Type text that you want to print.

Document Property Select a document property whose value
you want to print.

Job Property Select a job property whose value you want
to print.

Line Break Select this content type to force a line break.
The break occurs after the last character of
any prior text content.

Statistic Select a statistic whose value you want to
print.

Script Only select this option on the advice of your
software support representative.

2. Select the Content Value. The drop-down list has the available values for the selected
Content Type.

3. Optional: You can apply text modifier rules to the value of a document property, job
property, or job statistic Content Type. Click the icon to define one or more text modifier
rules to extract the exact value you need.

4. Type text in the Text to Modify field. RICOH ProcessDirector generates or extracts statistics
and properties as it processes each page group in the production PDF files. Because these
values are not available to RICOH ProcessDirector Plug-in for Adobe Acrobat, you must enter
a text value that is representative of the values that RICOH ProcessDirector processes. The
modifier rule is a template that is applied to all values of the content type that you selected.
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For example, you might need to print only the last four digits of a credit card number, and
you have stored the entire number in a document property. You select Document Property
as the Content Type, and select the credit card document property as the Content Value.
You define two Remove Character text modifier rules to strip dashes and spaces from the
number to make them all uniform, and then you define a Substring by Position rule to retain
only the last four digits. You do not need to know any single value of a document property to
create modifier rules, you need to know only the possible formats that could occur in your
PDF files.

5. Choose one of the following modifiers:

CCoonntteenntt mmooddiiffiieerrss

Modifier Action

Remove Character Type one character or a blank character (use the space bar to
type a blank character) that you want to remove from the
value. The character is case-sensitive. Then select one of these
buttons:
• Remove all instances of the character

The specified character is removed from all positions in the
value.

For example, an account number is: 324-1443255-11.
You can type a - to remove all - characters from the value,
producing 324144325511.

• Remove leading characters
The specified character is removed from the beginning of
the value. For example, if you type a blank character, all
blank characters are removed from the beginning of the
value.

• Remove trailing characters
The specified character is removed from the end of the
value. For example, if you type a blank character, all
blank characters are removed from the end of the value.

• Remove leading and trailing characters
The specified character is removed from the beginning and
end of the value. For example, if you type a blank
character, all blank characters are removed from the
beginning and end of the value.

Substring by Position Select Beginning of Line or End of Line from the Starting
From list. Select a number for First Position to indicate the
location of the first character in the text value. Select a number
for Number to Retain to indicate how many characters are
retained.
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Modifier Action

Substring by Delimiter Type a character or a blank character in the Delimiter field to
indicate where the text value is split into separate string
segments. The character and the text string are case-sensitive.

Select Beginning of Line or End of Line from the Starting
From drop-down menu.

Select a number for First Position to define the position of the
delimiter in the text string.

Select a number for Number to Retain to define the number
of text string segments to retain.

These examples show how to select text string segments by
specifying a delimiter:
• For the account number 324-1443255-11, you can use -

as the delimiter to split the value into these three text strings:
324, 1443255, and 11. Select Beginning of Line. To
select the second and third text strings (1443255 and 11),
select 2 for both First Position and Number to Retain.

• For the mailing address Eldorado Springs CO 80025, you
can use a blank character as the delimiter to split the value
into these four text strings: Eldorado, Springs, CO, and
80025. Select End of Line.

– To select the zip code, select 1 for both First Position
and Number to Retain.

– To select the state, select 2 for First Position and 1 for
Number to Retain.

– To select the city, select 3 for First Position and 10 for
Number to Retain. By specifying 10 for Number to
Retain, you can select city names with up to ten words.

Pad with Character Select Beginning of Line or End of Line from the Padding
Location list. Enter a character or a blank character as the
padding character into the Character to Pad with field.

Enter a number in theMinimum Padded Text Length field to
define the minimum length of the text string. If the number of
characters in the text string is less than this minimum length,
padding characters are added until the text string equals the
minimum length.

11. Click to add a new content definition row. After you have added all content types and
modifier rules to the text you are adding to the PDF file, you can place a check mark in the box

next to a content type and use the up and down icons to reorder the content. Use the icon to
delete selected content.

12. If you defined multiple lines of text and you want RICOH ProcessDirector Plug-in for Adobe
Acrobat to remove lines that only contain white space, click the Remove blank lines check box
to select it.
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13. Click OK to create the text configuration.

14. Click Ricoh→ Preview to verify the text has the content and page placement you intended.

15. Optional: You can edit the text definition by double-clicking its box or by right-clicking the box
and clicking Edit.

16. When you are ready to save all your enhancements to the PDF file, including the new text
definition, click Ricoh→ Save Control File.

17. Move the control file to a directory location that RICOH ProcessDirector can access.

18. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of the
control file that contains the text definition.

WWoorrkkiinngg wwiitthh ppaaggee iinnsseerrttss
The Inserts Manager dialog shows information about page inserts from other PDF files. You can add,
edit, and delete page inserts. You also can set the order in which RICOH ProcessDirector adds the
inserts to the documents in a job when the BuildPDFFromDocuments step runs.

The Inserts Manager dialog provides this information for each page insert:

• The PDF file column shows the directory path to the PDF file on the RICOH ProcessDirector primary
server.

• The Insert location column shows whether the pages are inserted before or after the pages in the
documents.

• The Pages column shows which pages in each PDF file are inserted.

• The Rule column shows the name of the rule that RICOH ProcessDirector uses to determine which
documents in a job receive the inserts when the BuildPDFFromDocuments step runs.

• The Sides column shows whether the insert is one-sided, two-sided, tumbled, or that the setting is
inherited from the job.

To add a page insert, click the icon.

To work with a page insert, select it. Click the icon to modify the page insert or the icon to delete
it.

RICOH ProcessDirector adds the inserts to the documents in a job in the order that they appear on the
Inserts Manager list, from top to bottom.

To revise the order in which inserts are added to the documents, select an insert. Click the icon or

the icon to move the insert up or down the list.

Inserting pages from other PDF files

In a PDF file, you can insert pages from other PDF files before each document that matches the
placement conditions, after each document that matches the placement conditions, or both. The inserted
pages increase the number of pages in each document, and you can apply markup to them.

To insert pages from other PDF files:
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1. Open a PDF file in Adobe Acrobat Professional and either load a control file that contains page
groups or define page groups.

2. Click Ricoh→Manage Inserts.

3. Click the icon.

4. Specify the first PDF file with pages that you want to insert:

• If you can access the file, click Browse in the File to Insert section. Navigate to the file.
Select it, and click Open.

• If you cannot access the file, type the full directory path to the file on the RICOH
ProcessDirector primary server.
For example, type /aiw/aiw1/insertpages/insert1.pdf on a Unix-based system or C:
\aiw\aiw1\insertpages\insert1.pdf on Windows.

Make sure that RICOH ProcessDirector can access the file when the
BuildPDFFromDocuments step runs.

5. To insert all pages in the file, click the All pages radio button.

To specify the pages for insertion, click the Specific pages radio button, and type the page
selection.

• Use a hyphen to separate the first and last pages in a page range.

• Use a comma to separate page selections.

• Type n to specify the last page.
For example, type 8-n,5,2 to insert the pages from 8 to the end of the insert file, followed by
pages 5 and 2.

6. In the Insert Location section, choose whether to insert the pages before or after the pages in the
documents that match the specified placement conditions.

7. In the Placement Conditions section, specify the documents that receive inserted pages:

• To insert pages before or after each document in the open PDF file, click the All documents
radio button.

• To insert pages before or after some documents but not others, click the Documents based
on a rule radio button.
From the list, choose the rule that defines the placement conditions.

You also can do these actions:

– To define a new rule, click the icon. See Defining a rule, p. 43 for more information.

– To go to the Rules Manager, click the icon.
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– Custom rules for page inserts can include conditions based on the values of job
properties, document properties, and document statistics (such as Stat.
TotalPagesInDocument and Stat.TotalSheetsInDocument).

– Conditions based on the values of conditional triggers or page statistics (such as Stat.
CurrentPageInJob and Stat.CurrentSheetInJob) do not work with custom rules for
page inserts. RICOH ProcessDirector evaluates whether a rule for page insertions applies
to a document before evaluating the information on the individual pages in a document.

– Pre-defined rules, such as All Front Pages or Last Back Only, add page inserts to all
documents or no documents. Because those rules do not restrict page inserts to specific
documents, do not use them for page inserts.

8. In the Sides section, specify whether you want to print the insert one-sided or two-sided.

Simplex
The insert prints on a single side of the paper.

Duplex
The insert prints on both sides of the paper, with the long side of the paper as the bound
edge.

Tumble
The insert prints on both sides of the paper, with the short edge of the paper as the bound
edge. The bottom of the front side of the sheet is the top of the back side of the sheet.

From print job
The insert prints on the sides specified in the print job.

9. Click OK.

10. To select another PDF file and specify how to insert pages, click the icon. Repeat the steps for
the first PDF file.

RICOH ProcessDirector inserts the pages from the PDF files in the order that the files appear on
the Inserts Manager list, from top to bottom.

For example, an Inserts Manager list has 4 rows. The PDF files provide the following inserts:

• Page 1 in the first PDF file is inserted before each document in the open PDF file.

• Pages 4–6 in the second PDF file are inserted before each document.

• Pages 2–4 in the third PDF file are inserted after each document.

• Page 3 in the fourth PDF file is inserted after each document.

The first document in the open PDF file has 6 pages. After RICOH ProcessDirector adds the
inserts, the first document has 14 pages, in this order:

• Page 1 from the first PDF file

• Pages 4–6 from the second PDF file

• Pages 1–6 from the original document

• Pages 2–4 from the third PDF file
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• Page 3 from the fourth PDF file

11. To change the order that RICOH ProcessDirector uses to insert pages into documents, select a

row on the Inserts Manager list. To move the row up or down the list, click the icon or the

icon.

12. When you finish adding PDF files to the list, click OK.

13. Optional: To verify that the pages have been inserted as you intended, click Ricoh→ Preview.

When you preview a PDF file with inserts, RICOH ProcessDirector Plug-in for Adobe Acrobat
checks whether the PDF files are at the directory paths you specified on the Inserts Manager list.

• If they are, the pages are inserted from the PDF files at those directory paths.

• If they are not, the pages are inserted from the PDF files that are embedded in the control file.

If RICOH ProcessDirector Plug-in for Adobe Acrobat cannot find an embedded PDF file, the
preview function displays a warning message and continues without inserting the pages.

14. When you are ready to save all your enhancements to the open PDF file, including the new
inserts, click Ricoh→ Save Control File.

In the control file, RICOH ProcessDirector Plug-in for Adobe Acrobat embeds the PDF files that it
can access.

If the PDF files are embedded, you need not copy them to a directory accessible to a RICOH
ProcessDirector server.

Whenever you save the control file, RICOH ProcessDirector Plug-in for Adobe Acrobat tries to
replace each embedded PDF file with the file at the directory path shown on the Inserts
Manager list.

15. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of
the control file that contains the pages to insert.

When a job with inserts from other PDF files enters the BuildPDFFromDocuments step, RICOH
ProcessDirector checks whether the PDF files are at the specified directory paths.

• If they are, the pages are inserted from the PDF files at those directory paths.

• If they are not, the pages are inserted from the PDF files that are embedded in the control file.

If RICOH ProcessDirector cannot find an embedded PDF file, the job moves to error state. The job
cannot complete the BuildPDFFromDocuments step until RICOH ProcessDirector can access all
the PDF files that provide inserts or until you remove the page insertion instructions from the
control file.

Example

Each document in a PDF file has from 1 to 3 pages. You want to insert page A at the end of documents
with 2 pages. You want to insert page A and page B at the end of documents with 1 page.

1. Define a rule named TotalPagesLessThan3 with 1 condition:
Stat.TotalPagesInDocument < 3

2. Define a page insert for page A and another page insert for page B.

3. For each page insert:
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• Click the After documents radio button.

• Click the Documents based on a rule radio button and select TotalPagesLessThan3.

4. Make sure that the insert for page A is above the insert for page B on the Inserts Manager list.

If a document has 1 or 2 pages, RICOH ProcessDirector adds page A. If the document now has 2
pages, RICOH ProcessDirector adds page B after page A.

MMeeddiiaa aanndd ffiinniisshhiinngg
You can specify media and finishing options for your sample PDF file and apply them as page
exceptions to the job-level media and finishing options specified for RICOH ProcessDirector jobs.

You can apply media and finishing options to a range of pages or to the documents (page groups)
within a PDF file. When applying media and finishing options to documents, you can use pre-defined
rules or custom rules. For example, you can use a pre-defined rule to print the first page of each
document on blue paper. You can define a custom rule so that each page with the words Premier
Member in the upper right corner prints on gold paper.

Media and finishing options that you specify with RICOH ProcessDirector Plug-in for Adobe Acrobat
override the options that RICOH ProcessDirector specifies for jobs.

• RICOH ProcessDirector Plug-in for Adobe Acrobat supports RICOH ProcessDirector media with
electronic forms. The Show electronic forms preference determines whether Preview shows how
sample files look when the data is combined with electronic forms defined for the media that the files
use.

You can preview the PDF file as you add media and finishing options to verify that they have been
applied to the intended pages.

Your media and finishing definitions are saved in the RICOH ProcessDirector Plug-in for Adobe Acrobat
control file. RICOH ProcessDirector uses the control file to apply the definitions to print jobs
automatically.

Managing media and finishing options

TheMedia and Finishing dialog shows information about your media and finishing options for a PDF
file. You can edit and delete options, select new media and finishing options, and set the order in which
RICOH ProcessDirector applies the options to a PDF file.

For each page-level media or finishing option, the Range column shows the page selection or the name
of the rule that RICOH ProcessDirector Plug-in for Adobe Acrobat uses to apply the option to documents
in the PDF file. The Paper substitution column shows media options, and the Subset finishing column
shows finishing options.

To specify a new page-level media or finishing option, click the icon.

To work with a page-level media or finishing option, select it. Click the icon to modify the option or

the icon to delete it.

2 Using RICOH ProcessDirector Plug-in for Adobe Acrobat
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To revise the order in which page-level media and finishing options are applied to the PDF file, select an
option. Then click the up or down arrow to move it.

RICOH ProcessDirector Plug-in for Adobe Acrobat applies the page-level options to the PDF file in the
order that they appear on the list, from top to bottom. If two page-level options specify conflicting
selections for the same page (for example, two different types of media), RICOH ProcessDirector Plug-
in for Adobe Acrobat applies the option that is lower on the list.

For example, the first option specifies Letter Blue media for the first page of each document in the PDF
file. The second option specifies Letter Gold media for the first page of each document for a Gold Club
member. When the PDF file is printed, the first page of every document for a Gold Club member prints
on Letter Gold media. The first page of every other document prints on Letter Blue media. If the option
for Letter Blue media is below the option for Letter Gold media, the first page of every document prints
on Letter Blue media. No first pages print on Letter Gold media.

The order of media options does not affect how RICOH ProcessDirector Plug-in for Adobe Acrobat
applies finishing options, and vice versa.

Selecting media and finishing options

You can select media and finishing options for specific pages in each page group by specifying a rule
or typing page numbers. For example, you can specify that pages 1–4 of each page group are
stapled. You can also specify that the first page of each page group prints on gold paper.

To select media and finishing options:

1. Click Ricoh→Media and Finishing and then click the icon.

2. Select a media option on the Paper substitution list or a stapling option on the Subset finishing
list.

• The media options are the names of RICOH ProcessDirector media objects specified in the
media.zip file (or the media.xml file from an older version of RICOH ProcessDirector). For
more information, see the topic about loading media objects in the help system or RICOH
ProcessDirector: Installing Document Processing Features.

3. Use the Placement Conditions section to specify the pages for the media or finishing option. Do
either of these steps:

• Select Pages based on a rule, and then select a rule from the list. The default rule is All
Pages. You can also:

– Define a new rule by clicking the icon. See Defining a rule, p. 43 for more
information.

– Go to the Rules Manager by clicking the icon.

• Select Specify pages and type the pages that you want. Media and finishing options are
applied to these pages in each page group. You can:

– Use a hyphen to separate the first and last pages in a page range.

Media and finishing
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– Use a comma to separate page selections.

– Type n to specify the last page in each page group.
For example, a PDF file has two page groups. The first has four pages, and the second
has seven pages. Specifying pages 3–n places markup on pages 3–4 in the first page
group, and pages 3–7 in the second.

4. Click OK.
The option that you specified appears on the media and finishing list.

5. If you have multiple options for paper substitution or subset finishing, select the new option. Use
the up and down arrows to move it into the proper position in the ordered list of options.

RICOH ProcessDirector Plug-in for Adobe Acrobat applies the page-level options to the PDF file
in the order that they appear on the list, from top to bottom. If two page-level options specify
conflicting selections for the same page (for example, two different types of media), RICOH
ProcessDirector Plug-in for Adobe Acrobat applies the option that is lower on the list.

6. To verify that RICOH ProcessDirector Plug-in for Adobe Acrobat has applied media and finishing
options to the intended pages:

1. Click Ricoh→ Preview.
If a page has media and finishing options, you see an annotation labeled Print Operations
in the upper right corner.

2. To see the media name and finishing option, hover the mouse pointer over Print Operations.

For example:

Media = Blue LetterStapling = Top left (#1)

(#1) indicates the sequence of the page in the finishing option. If you specify stapling for
pages 5–8, page 5 is #1 and page 8 is #4.

As an alternative, click Comment on the Adobe Acrobat toolbar. In the Comments pane,
you see a comment for each page with media and finishing options.

• The Show electronic forms preference determines whether Preview shows how sample
files look when the data is combined with electronic forms defined for the media that the
files use. Set the preference to Yes to see the data combined with the forms.

7. When you are ready to save all your enhancements to the PDF file, including the new media and
finishing options, click Ricoh→ Save Control File.

8. In the RICOH ProcessDirector BuildPDFFromDocuments step, specify the name and location of the
control file that contains the media and finishing definitions.

2 Using RICOH ProcessDirector Plug-in for Adobe Acrobat
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33.. Troubleshooting

•Determining the plug-in version
•Page groups do not display correctly
•You do not see markup on the correct pages in Preview
•Text selections show small boxes instead of text
•Fonts, images, or other resources are missing
•Fields in the RICOH ProcessDirector Plug-in for Adobe Acrobat cut off values
•Document properties are missing
•Media options are missing
•A font is not on the list when you add text to a PDF file
•Fonts with alternate letter forms do not display correctly
•QR barcode does not print Japanese data
•Error message tells you to check memory settings

If you encounter problems while you are working with RICOH ProcessDirector Plug-in for Adobe
Acrobat, you might be able to use these topics to help solve them.

DDeetteerrmmiinniinngg tthhee pplluugg--iinn vveerrssiioonn
About information includes the version number of RICOH ProcessDirector Plug-in for Adobe Acrobat
that you currently have installed.

To determine the version:

1. Open Adobe Acrobat Professional and click Ricoh→ About.

2. After viewing the information, click Close.

PPaaggee ggrroouuppss ddoo nnoott ddiissppllaayy ccoorrrreeccttllyy
When page groups based on repeated text do not display as you expected in the Page Group
Navigator, you have not correctly selected or specified the text for the page group.

You might need to adjust the width of the box that you drew or change the text that you specified.

If you selected the Begin page group when the selected text is found option, some characters in
the PDF file might include white space that you need to enclose in the box you drew.

YYoouu ddoo nnoott sseeee mmaarrkkuupp oonn tthhee ccoorrrreecctt ppaaggeess iinn PPrreevviieeww
Preview shows markup based on the Production Intent property value in Preview Preferences.

For example, when the Production Intent property value is Simplex and the page placement is
Second Front Only, Preview shows markup on the second page of each page group. When the
Production Intent property value is Duplex and the page placement is Second Front Only, Preview
shows markup on the third page of each page group.

If you do not see markup on the correct pages in Preview:

1. Click Ricoh→ Preview Preferences.

2. Check the setting of the Production Intent property value.
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TTeexxtt sseelleeccttiioonnss sshhooww ssmmaallll bbooxxeess iinnsstteeaadd ooff tteexxtt
If you select text in a PDF file (for example, if you select text for a page group or document property)
and the text you selected is represented by small boxes, your PDF file might be malformed. You cannot
enhance a malformed PDF file using RICOH ProcessDirector Plug-in for Adobe Acrobat.

Two ways to determine if your PDF file is malformed are:

• Use the Acrobat search tool to locate text that you see in the PDF file. For example, you see the
words "Account Number" on the first page of the PDF file. Type those words into the Acrobat search
tool and run the search. If Acrobat cannot locate the words, the PDF file could be malformed.

• Copy text from the PDF file and paste the text into the Acrobat search field. If the text you pasted in
the search field is different than the text you copied, your PDF file could be malformed.

FFoonnttss,, iimmaaggeess,, oorr ootthheerr rreessoouurrcceess aarree mmiissssiinngg
Your PDF files, for both RICOH ProcessDirector Plug-in for Adobe Acrobat and RICOH ProcessDirector,
must embed all their resources, including fonts and images.

FFiieellddss iinn tthhee RRIICCOOHH PPrroocceessssDDiirreeccttoorr PPlluugg--iinn ffoorr AAddoobbee AAccrroobbaatt
ccuutt ooffff vvaalluueess
Monitors with a very high resolution and certain display settings can cause problems in the way
information is displayed.

To change the way entry fields are displayed in the RICOH ProcessDirector Plug-in for Adobe Acrobat:

1. Right-click the Desktop and select Display settings.

2. Under Scale and layout, change the Change the size of text, apps, and other items value
to 100%.

3. Restart the computer for the change to take effect.

• If this change makes the fields too small to use, try changing the Resolution value.

DDooccuummeenntt pprrooppeerrttiieess aarree mmiissssiinngg
If you do not see the Document Property option in the Go to list in the RICOH ProcessDirector viewer,
check to ensure you have a step based on the IdentifyPDFDocuments step template in your workflow.
That step extracts document properties from a PDF file using the control file you generated from RICOH
ProcessDirector Plug-in for Adobe Acrobat.

If you do not see a specific document property, use RICOH ProcessDirector Plug-in for Adobe Acrobat,
load the control file you specified in the IdentifyPDFDocuments step, and verify that you defined the
specific document property. You also might not have the current RICOH ProcessDirector document
properties loaded.

If you do not see any document properties in the drop-down document property lists in RICOH
ProcessDirector Plug-in for Adobe Acrobat, you need to load them. Follow the steps in the help topic on
loading the RICOH ProcessDirector document property list.

For more information, see RICOH ProcessDirector: Installing Document Processing Features.

3 Troubleshooting
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MMeeddiiaa ooppttiioonnss aarree mmiissssiinngg
If you do not see RICOH ProcessDirector media objects on the Paper substitution list when you are
defining media options, RICOH ProcessDirector Plug-in for Adobe Acrobat does not have a current list
of RICOH ProcessDirector media objects.

RICOH ProcessDirector Plug-in for Adobe Acrobat gets media objects from a media.zip file (or a
media.xml file generated by an older version of RICOH ProcessDirector). When you install RICOH
ProcessDirector Plug-in for Adobe Acrobat and whenever you update media objects in RICOH
ProcessDirector, load media objects to RICOH ProcessDirector Plug-in for Adobe Acrobat. For more
information, see RICOH ProcessDirector: Installing Document Processing Features.

AA ffoonntt iiss nnoott oonn tthhee lliisstt wwhheenn yyoouu aadddd tteexxtt ttoo aa PPDDFF ffiillee
When you add text to a PDF file, the font list should include all fonts available to Adobe Acrobat except
for fonts that do not permit embedding in PDF files.

If the font list does not include a font that should be available:

1. Make sure that the font is installed in the Windows Fonts folder or the Resource\Font folder of
your Adobe installation.

2. If the font is installed, set the logging level to warning messages:

1. Click Ricoh→ Preferences.

2. On the Logging tab, clickWarn in the Logging Level section.

If certain installed fonts are not included in the fonts list when you add text to a PDF file, RICOH
ProcessDirector Plug-in for Adobe Acrobat issues a warning message with the reason. The
message is saved to the log file.

FFoonnttss wwiitthh aalltteerrnnaattee lleetttteerr ffoorrmmss ddoo nnoott ddiissppllaayy ccoorrrreeccttllyy
This version of RICOH ProcessDirector Plug-in for Adobe Acrobat does not support alternate letter
forms, including ligatures, swashes, and letter forms that vary according to where they appear in a
word. Right-to-left languages, such as Hebrew and Arabic, are rendered incorrectly.

When you add text to a PDF file, the drop-down list of fonts shows all fonts in the Windows Fonts
folder. The list might include fonts for right-to-left languages and fonts with unsupported alternate letter
forms.

QQRR bbaarrccooddee ddooeess nnoott pprriinntt JJaappaanneessee ddaattaa
If the data within the QR barcode should be encoded in Shift JIS (SJIS):

1. Double-click the box you drew that defines the QR barcode.

2. Click Settings and enter Shift_JIS in the encoding field.

The input data is always Unicode; however, this setting translates the Unicode characters into the
Shift JIS encoding for the content of the QR barcode.

Setting the encoding field to Shift_JIS or SJIS produces UTF-8 that is encoded in Shift JIS. This encoding
is not interpreted correctly on DoCoMo Imode phones (common in Japan). DoCoMo Imode phones are
compatible with encoding settings of: sjis, x-sjis, windows-31J, MS_Kanji, csShiftJIS, csWindows31J,

Media options are missing
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windows-932, cp943c, ibm-943. These encodings might produce different QR barcodes because they
have conflicting code points.

EErrrroorr mmeessssaaggee tteellllss yyoouu ttoo cchheecckk mmeemmoorryy sseettttiinnggss
If you are working with a large PDF source file and an error message tells you to check memory
settings, you might need to increase the RICOH ProcessDirector Plug-in for Adobe Acrobat memory
allocation.

To increase the memory allocation:

1. Click Ricoh→ Preferences→ Advanced.

2. Increase the Heap Size (MB).

3. Restart Adobe Acrobat.

3 Troubleshooting
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4. Accessibility

Ricoh strives to provide products with usable access for everyone, regardless of age or ability.

For more information about the commitment that we have made to accessibility, refer to the Accessibility
page on the Ricoh website.

Accessibility features

Accessibility features help users who have disabilities, such as restricted mobility or limited vision, use
information technology products successfully.

The major accessibility features in this product let you:

• Use screen readers, screen magnifiers, and other assistive technologies.

• Use a keyboard instead of a mouse.

• Change attributes such as volume, color, contrast, and font size.

• Distinguish keys by touch without activating them.

• Attach alternative input and output devices such as special pointing devices and Braille displays.

In addition, the information center and the publications for the product are in an accessible format.

RICOH ProcessDirector Plug-in for Adobe Acrobat Markup Navigator shortcut keys

When a markup object that you defined has focus in the Markup Navigator, you can use these shortcut
keys:

Markup Navigator shortcut keys

Description Key

Opens the Edit dialog Enter

Deletes a markup object Delete

Keyboard navigation

This product uses standard Microsoft Windows navigation keys.

https://www.ricoh-usa.com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility
https://www.ricoh-usa.com/en/about-us/corporate-responsibility-and-environmental-sustainability/accessibility
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